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  Welcome 
 
 
 
Congratulations on your purchase of a Magna-IR® E.S.P. System 
560 or 760 spectrometer!  The spectrometer lets you collect spectra 
in the mid-IR, near-IR, visible and far-IR spectral ranges.  The E.S.P. 
system integrates the advanced hardware features of the Magna-IR 
spectrometer with the power and flexibility of Nicolet’s OMNIC® 
software*. 
 
 

 

 
 
 
This manual explains how to use the system to collect and process 
FT-IR data after it is installed by Nicolet.  Included is information on 
using Nicolet’s OMNIC E.S.P. software as well as chapters on how 
to operate, maintain and service the spectrometer. 

                                                 
* Some dedicated systems, such as the Liquid Analysis System, use other Nicolet software 
packages. 
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 If you have not used the spectrometer before, use the “Getting Started” 
tutorial available in the Help menu of OMNIC or read the “Before You 
Collect Spectra” and “Your First Experiment” chapters to learn how to 
start the system and collect and work with spectra.  See “Where to find 
the information you need” later in this chapter for a description of the 
on-line documentation provided with the system and for help finding 
the answers to your questions. 
 
You can replace key parts of the spectrometer, such as the laser and 
light source.  Installation instructions are available on-line.  See 
“Where to find the information you need” for details.  
 
Instructions for most accessories are included with the particular 
accessory.  Additional information on connecting accessories is 
included in this manual. 
 
If you have questions, contact Nicolet at one of the numbers below.  
Outside the U.S.A. call your local sales or service representative.  
Telephone numbers for all Nicolet Customer Support offices are 
provided with your system. 
 
• Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538) 
• Fax: 1-608-273-6045 
• World Wide Web: http://www.nicolet.com 
• E-mail: nicinfo@nicolet.com ▲ 
 

    Warning The Optical Bench Safety Guide that came with your system contains 
important safety information.  This guide is available in several 
languages.  Contact your local Nicolet office for information about 
the languages that are available.  Before you use the system, read the 
entire guide.  To prevent personal injury and damage to equipment, 
follow the safety precautions contained in the guide whenever you 
use the system. ▲ 
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Conventions 
used in this manual 

The following conventions are used in this manual to draw your 
attention to the on-line documentation and other important 
information. 
 
 

 
This symbol (shown enlarged here) tells you that you can find more 
information in the on-line tutorials or OMNIC Help system.  You can 
access all of the on-line tutorials as well as the Help system by clicking 
the Help menu in OMNIC. 
 
 

 Note Messages like this contain helpful supplementary information about 
a procedure or technique. ▲ 
 
 

 ▲ Caution Follow the instructions given in Cautions to avoid damaging the 
spectrometer or losing data. ▲ 
 
 

    Warning Always heed the Warnings that appear in this manual to avoid being 
injured while using the spectrometer. ▲ 
 
 

   Danger Follow the instructions labeled Danger to avoid serious injury or loss 
of life while using the spectrometer. ▲ 
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Where to find the 
information you need 

The on-line and printed documentation included with your system is 
designed to let you find the information you need quickly.  We 
recommend first using the on-line documentation provided with 
OMNIC when you have a question.  OMNIC includes several on-line 
tutorials, a wizard and a complete Help system.  See “Starting 
OMNIC” in the “Before You Collect Spectra” chapter for information 
on starting OMNIC. 
 

 Note The on-line tutorials are available only if you are using Windows 95 
or Windows NT 4.0. ▲ 
 
The tutorials teach you how to do these things: 
 
• Use various OMNIC features to collect, display and process 

spectra. 
 

• Set up your spectrometer for a variety of experiments.  You can 
learn how to change detectors, sources and beamsplitters; install 
optical filters and screens; change the sample compartment 
baseplate; and change the Flex-Top™ adapter plate in the sample 
compartment cover. 

 

• Install optional hardware. 
 

• Check and change the desiccant, purge filters and fuses. 
 

• Change replaceable parts. 
 

• Get part number and ordering information. 
 

 Note You must have the Spectrometer Tutorials CD in the computer to use 
the Spectrometer Tour or any parts replacement tutorials. ▲ 
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You can also check parts lists or find other information without 
using the computer connected to the spectrometer.  Insert the 
Spectrometer Tutorials CD into any Windows 95 computer and 
double-click the icon for the following programs to see information: 
 
P560_ENU.HLP Part numbers and replacement procedures for a 

560 system 
P760_ENU.HLP Part numbers and replacement procedures for a 

760 system 
S560_ENU.EXE Spectrometer tour for a 560 system 
S760_ENU.EXE Spectrometer tour for a 760 system 
 
To use a tutorial, point to Learning OMNIC in the Help menu and 
then choose the desired tutorial from the list that appears.  Tutorials 
also appear in these Help menus: Replacing Parts, Installing 
Hardware and Troubleshooting.  You can also start tutorials from 
within other parts of the on-line documentation provided with 
OMNIC. 
 
The Library Creation Wizard prompts you, step by step, through 
creating a user library of spectra.  
 
The OMNIC on-line Help system lets you quickly find answers to 
your questions about using the software.  There are several ways to 
enter the Help system: 
 
• If you have Windows 95 or Windows NT 4.0, you can see 

information about a particular feature in OMNIC (such as a menu 
command, a parameter in a dialog box, etc.) by clicking the item 
using the right mouse button.  A brief description of the item 
appears, and in most cases one or more buttons that you can click 
to display more detailed information.  Click the Discussion 
button to display a complete discussion of the item (or the dialog 
box or window that contains the feature).  Click the How To 
button to display a step-by-step procedure for using the item (or 
the dialog box or window that contains the item). 
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• You can press the F1 function key at any time to see a discussion 
topic for the currently displayed or selected feature, dialog box or 
window. 

 
• If a dialog box or window contains a Help button, click it to see 

information about the dialog box or window (or the command 
that displayed it). 

 
• To see the Contents of the OMNIC Help system, choose OMNIC 

Help Topics from the Help menu. 
 
Use the following sections to help you locate the information you 
need. 
 
 

The basics How do I turn on the system? 

 

 View the “Powering Up” unit of the “Spectrometer Tour” tutorial. 
 
See “Turning on the system components” in the “Before You Collect 
Spectra” chapter of this manual. 
 
 
How do I start the software? 

 See “Starting OMNIC” in the “Before You Collect Spectra” chapter of 
this manual. 
 
 
How do I prepare the software for data collection? 

 View the “Preparing the Software” lesson of the “Collecting a 
Spectrum” tutorial. 
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How can I learn how to use the software? 

 View the tutorials listed when you point to Learning OMNIC in the 
OMNIC Help menu. 
 
 
What hardware and software do I need? 

For optimum performance we recommend that your system have, at 
a minimum, the following items: 
 
• Intel® Pentium® processor with 100 MHz or greater clock speed. 

• At least 16 megabytes of random access memory (RAM). 

• The capability of displaying at least 256 colors. 

• Hard disk size of at least 1.0 gigabyte. 

• Quad speed CD-ROM drive. 

• A 1.44-megabyte floppy disk drive for 3.5-inch floppy disks. 

• A 15-inch SVGA monitor with 800 by 600 resolution. 

• A keyboard and serial or bus mouse or PS/2®-style mouse. 

• A 16-bit Sound Blaster-compatible sound card. 

• Two serial ports. 

• An ECP bidirectional parallel port. 

• Three ISA/PCI slots. 

• One of the following versions of Windows software: 
- Windows 95 (recommended, provides all the features) 
- Windows NT 4.0 or greater (recommended NT version, can 

be used on a workstation system or with a Magna-IR or 
Protégé spectrometer) 

- Windows NT 3.51 or greater (minimum NT version, can be 
used only on a workstation system) 

- Windows 3.1 or greater (minimum version, does not provide 
all the features) 

 
 

 



8       Nicolet 

Using the 
spectrometer  

and changing parts 

What’s inside the spectrometer? 

 
 
How does the spectrometer work? 

 For an overview of the theory behind FT-IR, see the “Beginner’s 
Guide to FT-IR” tutorial. 
 
 
How do I purge the system?  

 View the “Purging the optical bench” lesson in the “Preparing Your 
Optical Bench” unit of the “Collecting a Spectrum” tutorial. 
 
See also instructions for using the Purge Curtain in the “Sample 
Compartment” lesson of the “From the Front” unit of the 
“Spectrometer Tour.” 
 
 
How do I change beamsplitters? 

 Choose Replacing Parts from the OMNIC Help menu and view the 
“Changing beamsplitters” tutorial in the “Replacing parts” book. 
 
See “Selecting the right beamsplitter and detector” in the “Using 
beamsplitters and detectors” section of the “Optical Bench Basics” 
chapter of this manual for tables showing the compatibility of sources, 
beamsplitters and detectors. 
 
 
How do I change detectors? 

 Choose Replacing Parts from the OMNIC Help menu and view the 
“Changing detectors” tutorial in the “Replacing parts” book. 
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See “Selecting the right beamsplitter and detector” in the “Using 
beamsplitters and detectors” section of the “Optical Bench Basics” 
chapter of this manual for tables showing the compatibility of 
sources, beamsplitters and detectors. 
 
 
How do I install a source? 

 Choose Replacing Parts from the OMNIC Help menu and view the 
“Changing your source” tutorial in the “Replacing parts” book. 
 
See “Selecting the right beamsplitter and detector” in the “Using 
beamsplitters and detectors” section of the “Optical Bench Basics” 
chapter of this manual for tables showing the compatibility of sources, 
beamsplitters and detectors. 
 
 

 

Collecting spectra Which beamsplitter and detector should I use? 

 

 Choose Replacing Parts from the OMNIC Help menu.  Then view the 
“Selecting a beamsplitter, detector, and source” tutorial in the 
“Replacing parts” book for tables showing the compatibility of 
sources, beamsplitters and detectors. 
 
See “Selecting the right beamsplitter and detector” in the “Using 
beamsplitters and detectors” section of the “Optical Bench Basics” 
chapter of this manual for these tables. 
 
 
How do I install a sample? 

 View the “Installing samples” unit of the “Spectrometer Tour” tutorial.
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How do I collect a spectrum? 

 View the “Collecting a Spectrum” tutorial, listed when you point to 
Learning OMNIC in the OMNIC Help menu. 
 
See the “Your First Experiment” chapter of this manual for a lesson on 
collecting spectra. 
 
 
 

Accessories What accessories are available? 
 

 View the “Accessories” unit of the “Spectrometer Tour” tutorial for a 
general description of the available accessories, or see the “Accessories 
You Can Buy and How to Install Them” chapter of this manual.  
 
 
How do I install an accessory? 

 Check the “Installing optional hardware” and “Replacing parts” help 
books listed when you choose Installing Hardware in the OMNIC Help 
menu.  These help books provide step-by-step instructions and, in 
many cases, on-line videos to help you install accessories.  If the 
accessory you purchased is not covered on-line, use the instructions 
that come with the accessory. 
 
 

Maintenance and service How should I maintain my spectrometer? 
 

 
View the “Service and maintenance” unit of the “Spectrometer Tour” 
tutorial for information on maintaining the spectrometer.  You can also 
choose Replacing Parts from the OMNIC Help menu and view the 
tutorials in the “Maintaining your optical bench” book. 
 
See the “Service and Maintenance” chapter of this manual for 
information on maintaining the spectrometer. 
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What should I do if there is a problem with the system? 

Contact Nicolet at one of the numbers below.  Outside the U.S.A. 
call your local sales or service representative.  Telephone numbers 
for all Nicolet Customer Support offices are provided with your 
system. 
 
• Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538) 
• Fax: 1-608-273-6045 
• World Wide Web: http://www.nicolet.com 
• E-mail: nicinfo@nicolet.com ▲ 
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  Before You Collect Spectra 
 
 
 
It’s easy to collect spectra with your spectrometer.  By leaving the 
system turned on at all times—with the needed components already 
installed—you can keep it ready to use with a minimum of 
preparation.  Keeping the system on also improves its stability and 
gives you more consistent results. 
 
All the things you need to check are listed below; each of these items 
is discussed in a section of this chapter.  By the time you have run 
through these items once or twice in the course of your work, you 
will know how to check the system and start collecting spectra 
quickly. 
 
• Check the purge or desiccant indicator. 
• Make sure the system components are on. 
• Cool the detector (if required). 
• Open an experiment. 
 
If you have questions, contact Nicolet at one of the numbers below.  
Outside the U.S.A. call your local sales or service representative.  
Telephone numbers for all Nicolet Customer Support offices are 
provided with your system. 
 
• Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538) 
• Fax: 1-608-273-6045 
• World Wide Web: http://www.nicolet.com 
• E-mail: nicinfo@nicolet.com ▲ 
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Checking the purge 
 

Skip this section if you purchased  
the “Sealed and Desiccated” option. 

If your spectrometer is purged, make sure both purge shutters are open 
(handles in the down position) whenever the sample compartment door 
is closed.  This allows the purge gas to flow between the sample 
compartment and the rest of the spectrometer so that the entire 
spectrometer is purged. 
 
 

Handles down
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Also make sure the pressure regulator is set between 20 and 40 
pounds per square inch (psi) and the flowmeter is set to 25 standard 
cubic feet per hour (scfh). 
 
 

80
100

120

140

1600

20

40

60

50
40
30
20
10

SCFH AIR

 
 
 

   Warning Never use a flammable gas to purge the spectrometer.  The purge gas 
must be free of moisture, oil, carbon dioxide and other reactive or 
infrared-absorbing materials.  We recommend using dry air or 
nitrogen. ▲ 

 
We recommend that you leave the purge on at all times.  This keeps 
the spectrometer free of undesirable gases, protects the optics and 
improves the system’s thermal stability. 
 

 Choose Installing Hardware from the OMNIC Help menu and view the 
tutorials in the “Maintaining your optical bench” book for information 
on how to install the purge equipment, set the controls for the first 
time, and inspect and clean the purge filter.  View the “Sample 
compartment” topic in the “Spectrometer Tour” for information on 
using the Purge Curtain. 
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Turning on the 
system components 

We recommend that you keep your spectrometer on at all times, unless 
the building is subject to power outages or you need to perform a 
service or maintenance procedure.  Leaving the system on keeps it 
stable and gives you the most consistent results.  If you must turn the 
spectrometer off, allow it to stabilize for at least 15 minutes (one hour 
for best results) before collecting spectra. 
 
Follow these steps to turn on the system components: 
 
1. Turn on any accessories you plan to use. 

This includes accessories such as the Raman Accessory for 
Magna-IR, a gas chromatograph and GC interface, or an infrared 
microscope. 
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2. Turn on the spectrometer. 

Press the power switch on the rear panel to I. 
 
 

Auxiliary 1 Auxiliary 2

 
 
 

    Warning Always follow the safety precautions described in this manual and in 
the Optical Bench Safety Guide that came with your system. ▲ 
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 ▲ Caution The electronics compartment is located under the cover in the top-
left-rear corner of the spectrometer. 

 
 

 

Electronics cover

 
 
 

To avoid overheating the electronic components, do not place 
anything on top of the electronics cover. ▲ 
 
After you turn on the spectrometer, let it stabilize for at least 15 
minutes (one hour for best results) before collecting spectra. 
 
See “Turning on the optical bench power” in the “Optical Bench 
Basics” chapter if you want more information on turning on the 
spectrometer. 
 
 

3. Turn on the computer and printer. 

Turn on the computer and printer as explained in the 
documentation that came with those components. 
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Cooling the detector 
 

 

Some detectors, such as an MCT or InSb detector, require cooling with 
liquid nitrogen.  Choose Installing Hardware from the OMNIC Help 
menu and view the “Cooling a detector” tutorial in the “Installing 
hardware” book for information on how to cool an MCT detector. 
 

   Warning Liquid nitrogen is extremely cold and therefore potentially 
hazardous.  Avoid contact with skin.  Wear protective clothing and 
follow standard laboratory safety practices to prevent injury. ▲ 
 
After you fill the detector dewar with liquid nitrogen, allow the 
detector to cool at least 20 minutes before collecting spectra. 
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Installing OMNIC If you need to install OMNIC on your hard drive, follow these 
directions.  The procedure for installing OMNIC depends on the 
version of Windows™ you are using. 
 
If you have Windows 95 or Windows NT 4.0, follow these 
instructions: 
 
Start your Windows software and insert the OMNIC CD into the 
drive. 
 
The installation automatically starts. 
 
If the Autorun setting is off, or if you are installing the software from 
floppy disks, use the Add/Remove Programs dialog box in Windows 
95 to install OMNIC.  Click the Start button and choose Control 
Panels from Settings.  Double-click the Add/Remove Programs icon, 
and then choose the Install/Uninstall tab in the window.  Click the 
Install button and follow the directions to install the OMNIC 
software. 
 
If you have Windows 3.1 (or 3.11) or Windows NT 3.5, follow these 
steps: 
 
1. Start your Windows software and insert the OMNIC CD into 

the drive. 

 
2. Choose Run from the Program Manager File menu. 

 
3. Type X:setup (where X is the drive letter for your CD-ROM 

drive).  Then press Enter. 
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Starting OMNIC The procedure for starting OMNIC depends on the version of 
Windows you are using. 
 
If you have Windows 95 or Windows NT 4.0, follow these steps: 
 
1. Start your Windows software. 

 
2. Double-click the OMNIC E.S.P. shortcut. 

The OMNIC shortcut is on the Windows desktop. 
 
 

 
 
 
Depending on how the program has been configured, dialog 
boxes may appear asking for a user name and password.  Type in 
your user name if requested, and then choose OK.  Enter a 
password if required. 
 
The OMNIC window appears.  This window is described in the 
next chapter. 
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If you have Windows 3.1 (or 3.11) or Windows NT 3.5, follow these 
steps: 
 
1. Start your Windows software and display the Program 

Manager window. 

 
2. Open the group window that contains the OMNIC icon. 

The OMNIC icon is normally located in the OMNIC group 
window.  The icon looks like this: 
 
 

 
 

 
If the OMNIC group window is not open, you can open it by 
double-clicking its icon. 
 
 

3. Double-click the OMNIC icon to start OMNIC. 

Depending on how the program has been configured, dialog 
boxes may appear asking for a user name and password.  Type in 
your user name if requested, and then choose OK.  Enter a 
password if required. 
 
The OMNIC window appears.  This window is described in the 
next chapter. 
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Selecting 
an experiment 

By selecting an experiment from the Experiment drop-down list box 
below the OMNIC menu bar, you can quickly set the software 
parameters for the type of data collection you want to perform.  A 
number of experiments are provided with OMNIC, and you can create 
and save your own. 
 
If you want to check or change the parameters after selecting an 
experiment, use Experiment Setup in the Collect menu. 
 

 To learn more about experiments, see the “Preparing the Optical 
Bench” lesson in the “Collecting a Spectrum” tutorial.  If you need to 
install or change a source, beamsplitter or detector for your 
experiment, follow the instructions in the “Replacing parts” tutorial 
available in the OMNIC Help menu. 
 

 Note The most commonly used hardware configuration for mid-IR 
experiments includes a KBr beamsplitter, an Ever-Glo (mid-IR to 
far-IR) source and a DTGS detector.  You may need to change the 
settings of the example experiment if your hardware configuration is 
different. ▲ 
 

 You are now ready to collect spectra.  If you have not used the system 
before, you can learn how to perform an experiment by viewing the 
“Collecting a Spectrum” tutorial available in the Help menu of 
OMNIC or using the tutorial in the next chapter of this manual. 
 



24       Nicolet 

 



 

Magna-IR 560 and 760 User’s Guide       25 

  Your First Experiment 
 
 
 
This chapter will get you started collecting spectra with your 
spectrometer and working with the data using OMNIC.  You will 
learn how to do the following things: 

 

• Find the on-line tutorials, wizards and Help system. 
• Open a configuration. 
• Select an experiment and check the parameters. 
• Install a sample and collect a sample spectrum. 
• Label peaks in a spectrum. 
• Search a spectrum against a library. 
• Create and print a report. 
• Add a spectrum to a user library. 
 

 You can learn all these things and more by running the on-line tutorials 
provided with OMNIC.  Start with the “Getting Started” and 
“Spectrometer Tour” tutorials available through the OMNIC Help 
menu. 
 
Follow the instructions in the preceding chapter to prepare the 
system and start OMNIC before using this chapter.   
 
If you have questions, contact Nicolet at one of the numbers below.  
Outside the U.S.A. call your local sales or service representative.  
Telephone numbers for all Nicolet Customer Support offices are 
provided with your system. 
 
• Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538) 
• Fax: 1-608-273-6045 
• World Wide Web: http://www.nicolet.com 
• E-mail: nicinfo@nicolet.com ▲ 
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 Note If you have a dedicated system (such as an ECO/RS or a Liquid 
Analysis System) that normally uses a software package other than 
OMNIC, skip this chapter.  See the special documentation that came 
with your system for instructions on using that software.  If you need 
information on using the spectrometer, see the chapters that follow 
this one. ▲ 

 
 

The OMNIC window The large window that appears on the screen when you start OMNIC is 
called the OMNIC window. 
 
 

   
 
 
Within the OMNIC window is a spectral window, which you can use 
to display and manipulate spectra.  When a spectrum is displayed in 
a spectral window, you can use OMNIC commands to perform 
operations on it.  For example, you can change the spectrum’s format 
or search it against a spectral library to identify it. 
 
Below the title bar is the menu bar, which contains all of the OMNIC 
menu names.  The menus are arranged in an order that you’ll find 
convenient as you use the software.  All of the menu commands are 
explained in detail in the on-line tutorials or the OMNIC Help 
system. 
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Below the menu bar is the Experiment drop-down list box.  The 
Experiment drop-down list contains all of the experiment files you 
have opened, plus the default experiment file and an experiment file 
for any Smart accessory you have installed.  By selecting an 
experiment with this feature, you can quickly set the software 
parameters for the type of experiment you want to perform.  You can 
see the parameter settings for the selected experiment by using 
Experiment Setup in the Collect menu. 
 

 

 

To the right of the Experiment drop-down list box is the Bench Status 
indicator.  The indicator is a green check mark when the spectrometer 
is operating properly.  If there is a problem with the spectrometer, the 
indicator turns to a yellow circle or red X.  A yellow circle indicates 
that the spectrometer has failed a performance test, but the failure is 
usually not serious enough to prevent you from collecting usable 
spectra.  A red X indicates that the spectrometer has failed a 
performance test that requires corrective action.  Diagnostic 
information appears allowing you to troubleshoot the problem. 
 

 Note If you wish to view the on-line videos to help you in troubleshooting 
a problem, put the Spectrometers Tutorials CD in the computer. ▲ 
 
Below the Experiment drop-down list box is the toolbar.  Each 
button in the toolbar represents the action taken by a corresponding 
command or feature.  To see the name of the command or feature for 
a button, point to the button and press the right mouse button.  To 
initiate the command or feature, click the button with the left mouse 
button. 
 

 In the OMNIC Help system Index, find “toolbar” and go to the 
“Displaying and using a toolbar” topic for information on using and 
customizing the toolbar buttons. 
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Collecting a 
sample spectrum 

A sample spectrum is usually ratioed against a background spectrum.  
The background spectrum measures the response of the spectrometer 
without a sample in place.  Dividing the sample spectrum by the 
background—called “ratioing”—removes the effects caused by the 
instrument and atmospheric conditions so that the peaks in the final 
spectrum are due solely to the sample. 
 
Here is a typical background spectrum: 
 
 

 
 
 
For most applications you don’t need to collect a new background 
spectrum for each sample spectrum if you haven’t changed the 
software parameters.  To obtain good results, however, collect a new 
background regularly, perhaps once every four hours.  (You can 
obtain the best results by collecting a new background for each 
sample, but this is seldom necessary.) 
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Installing the 
standard sample holder 

If the standard sample holder is not already installed, install it now.  
Follow these steps: 

 

1. If your spectrometer is purged, close the purge shutters 
(handles in the up position). 

This helps keep water vapor and carbon dioxide out of the 
spectrometer.   

 
 

 

Handles up

 
 
 

 View the “Purging the optical bench” lesson in the “Preparing 
Your Optical Bench” unit of the “Collecting a Spectrum” tutorial if
you want to read more about purging the spectrometer and using 
the purge shutters. 
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2. Install the sample holder. 

The following illustration shows the sample holder in place. 
 
 

 

Accessory 
support

Sample holder

Height 
adjustment 

screw

 
 
 

 

 

 

If you are using separate Snap-In™ sample compartment baseplates
for different accessories and sample holders, you can quickly 
switch baseplates to install the sample holder.  For information on 
using Snap-In baseplates, choose Replacing Parts from the OMNIC 
Help menu.  Then choose the “Removing the snap-in baseplate” 
topic from the “Replacing parts” book. 

 



 

Magna-IR 560 and 760 User’s Guide       31 

If your sample holder is not installed on a baseplate, use a flat 
bladed screwdriver and the slotted screws to attach the holder to 
a baseplate as shown below.  Then install the baseplate in the 
sample compartment. 
 
 

 
 

 
If there is a sample in the holder, remove the sample.   
 
To install a sample or filter, slide the sample or filter into one 
pair of slots.  If the accessory support is currently installed in the 
slot you want to use, remove the support before installing the 
sample or filter (see the preceding illustration).  Replace the 
support when you are finished using the slot.  Do not discard the 
support; it is needed for installing slide-mounted accessories. 
 
 

3. Close the sample compartment cover and its sliding door. 
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4. If your spectrometer is purged, open the purge shutters 
(handles in the down position). 

Allow 1 minute for purge to be reestablished before collecting 
the polystyrene spectrum in the following procedure. 

 
 

Collecting the 
sample spectrum 

In the data collection procedure that follows, you will collect a 
background before collecting a polystyrene sample spectrum.  By 
selecting one of the experiments provided with OMNIC, you will 
quickly select this background handling option as well as set other 
software parameters before you collect the spectra. 
 
You will also open a configuration that sets a number of software 
options for this procedure.   
 

 You can also learn how to collect spectra by using the “Collecting a 
Spectrum” tutorial available through the Learning OMNIC item in the 
Help menu. 
 
Follow these steps to collect the sample spectrum: 
 
1. Choose Open Configuration from the File menu. 

The Open Configuration dialog box appears listing the available 
configuration files.  Opening one of these files lets you quickly 
set a number of software options. 

 
 
2. Select the DEFAULT.CON file and then choose OK. 

This file was provided with your OMNIC software for setting the 
options for this procedure. 
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3. Click the arrow button at the right end of the Experiment 
drop-down list box. 

 

 
 
 

The Default - Transmission experiment appears in the list.   
 

A number of other experiments are included for performing a 
wide variety of data collections.  You can install experiments by 
choosing Open from the Experiment Setup dialog box.  You can 
also set up and save your own experiments. 

 
 
4. Select the Default - Transmission experiment by clicking it. 

The parameters in the Experiment Setup dialog box are now set 
correctly for collecting a polystyrene sample spectrum. 

 
 
5. You can check the settings of the parameters by choosing 

Experiment Setup from the Collect menu. 

The Experiment Setup dialog box appears. 
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6. Click the Collect tab to display the data collection 
parameters. 

 

 
 
 

 The data collection parameters, along with the other experiment 
parameters, determine how OMNIC collects background and 
sample spectra.  See the OMNIC Help system for complete 
information on the parameters. 

 
Notice that the Collect Background Before Every Sample option 
is selected.  This option prompts you to collect a background 
spectrum before you collect a sample spectrum. 

 
The File Handling box contains options for saving data 
automatically.  When Save Automatically is on, OMNIC saves 
collected spectra immediately after collection, naming the files 
using the base name specified in the Base Name box plus a 
sequence number with up to four digits, followed by an extension 
such as .SPA for spectra.  The files are saved using the path 
shown below the base name.   
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If Save Interferograms is on, the interferograms for your spectra 
are saved when you save the spectra.  Interferograms are the raw 
spectral data.  Saving them allows you to reprocess a spectrum 
later in case you want to restore it after performing corrections or 
other operations on the data. 

 

 Leave the options in the File Handling box as they are for this 
procedure.  In the OMNIC Help system Index, find “file” and go to 
the “File handling” topic if you want more information on the File 
Handling options. 

 
 
7. Click the Bench tab to display the spectrometer parameters. 

Verify that the Beamsplitter, Detector and Source settings match 
the components you have installed in your system. 
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8. Choose OK to close the Experiment Setup dialog box. 

Now that you have selected the Default - Transmission 
experiment, you can collect a spectrum of the polystyrene 
sample. 

 
 
9. Choose Collect Sample from the Collect menu. 

 
You can also click the Collect Sample button in the toolbar to 
begin collecting the sample.  The Collect Sample window appears 
and then a dialog box showing the default title for the sample 
spectrum: 

 
 

  
 
 

10. Type a title in the text box or choose OK to accept the default 
title for the spectrum. 

Since the Default - Transmission experiment specifies that a 
background should be collected before every sample, a message 
appears now asking you to prepare to collect a background 
spectrum.   
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This means that you need to remove any sample from the sample 
holder so that the beam path is clear.  When you then collect a 
background spectrum, the result is a measurement of the 
response of the spectrometer alone; that is, without absorptions 
due to a sample. 

 
 
11. Look through the sliding door to make sure there is no 

sample in the sample holder and then choose OK to start 
data collection. 

If there is a sample in the sample holder, close the purge shutters 
(handles in the up position), open the sliding door, remove the 
sample, close the sliding door, open the purge shutters (handles 
in the down position) and then wait 1 minute before choosing 
OK.  The illustration in the next step shows the location of the 
purge handles. 

 
A background spectrum appears in the Collect Sample window.  
The spectrum is updated as more data are collected.  When all the 
background data have been collected, a message appears asking 
you to prepare to collect the sample spectrum: 
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12. If your spectrometer is purged, close the purge shutters 
(handles in the up position) before opening the sliding door 
in the next step. 

 

 

Handles up

 
 

 
 

 
This helps keep water vapor and carbon dioxide out of the 
spectrometer.  View the “Purging the optical bench” lesson in the 
“Preparing Your Optical Bench” unit of the “Collecting a 
Spectrum” tutorial if you want to read more about purging the 
spectrometer and using the purge shutters. 
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13. Install the polystyrene sample. 

First open the sliding door. 
 

Next insert the sample into the sample holder. 
 

 
 
 

Then close the sliding door. 
 

 View the “Installing Samples” unit of the “Spectrometer Tour” tutorial 
for more information on installing samples. 

 
 
14. If you closed the purge shutters earlier, open them (handles 

in the down position). 

Allow 1 minute for the purge to reach equilibrium before going 
to the next step.  If you had left the purge shutters open when you 
inserted the sample, you would need to wait 3 to 5 minutes. 
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15. Choose OK to start sample data collection. 

As data are collected, the sample spectrum in the Collect Sample 
window is updated.  Here is the Collect Sample window during 
sample data collection: 
 
 
 
 

 
 

Sample spectrum 
 
 

16. Monitor the status of the data collection. 

The progress of the collection is indicated visually by the 
collection gauge above the tool palette.  The number of scans 
collected so far and the total number of scans for the collection 
are displayed to the right of the gauge. 

 

Collect Status indicatorCollection gauge Tool palette View finder
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The Collect Status indicator above the view finder shows the 
status of the collection during and after collection.  The indicator 
is a green check mark, showing that the spectrum has passed all 
of the selected spectral quality checks made so far.  After the 
collection is finished and the indicator is a green check mark, you 
can add the spectrum to a spectral window (if it is not 
automatically added). 
 
If you ever have a problem with data collection, the Collect 
Status indicator may change.  If the indicator is a yellow circle, 
the spectrum has failed a spectral quality check (a measured 
value was not within the allowed range), but it is not serious 
enough to stop the collection. 
 
If the indicator is a red X, there is a problem with the quality of 
the spectrum.  After correcting the problem, collect the spectrum 
again. 
 
To view information about the collection, including any 
problems that have occurred, click the indicator during or after 
the collection, or click the View Collect Status button as 
explained below. 
 
When all the sample data have been collected, the following 
message appears asking whether to add the spectrum to a spectral 
window: 
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Clicking the View Collect Status button displays the Results 
window, showing a summary of any problems encountered 
during data collection and other information about the collection. 
 

 
17. Choose Yes to add the sample spectrum to the spectral 

window. 

(Choosing No ends the procedure without saving the spectrum.  
Choosing Cancel returns you to the Collect Sample window, 
allowing you to collect more scans with the More button.) 
 
Here is the sample spectrum displayed in the spectral window: 
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Saving the spectrum You can save your spectrum manually on the hard disk by using either 
of two commands in the File menu:  Save or Save As.  Use Save when 
you want to save a spectrum on the disk using the current filename and 
path.  In this example you will use Save As to save a spectrum in a file 
on the disk using a new filename. 
 
Follow these steps to save the polystyrene spectrum you just 
collected: 

   
1. Select the polystyrene spectrum by clicking it. 

 
2. Choose Save As from the File menu. 

The Save As dialog box appears.  This is a standard Windows 
dialog box. 

 
 
3. Type the name POLY.SPA following the directory path in 

the File Name box so that the text reads 
C:\OMNIC\SPECTRA\POLY.SPA. 

The text can be either upper or lower case.  The default directory 
path for saving files is determined by the settings on the File tab 
of the Options dialog box, available through Options in the Edit 
menu. 

 
 
4. Choose OK. 

If you typed a filename that already exists in the directory, a 
message appears asking whether to replace the existing file.  
Choose No and then use a different filename to save the 
spectrum. 

 
In the next section, you will convert the spectrum to absorbance. 
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Converting the 
spectrum’s units 

The polystyrene spectrum you collected is in absorbance units.  Since 
many of OMNIC’s data manipulation commands work best on spectra 
in absorbance units, it is useful to convert a spectrum to absorbance by 
using the Absorbance command.  For this example you will convert the 
spectrum to % transmittance and then back to absorbance. 
 
1. Select the spectrum by clicking it.  

 

 
2. Choose the Transmittance button in the toolbar. 

You can also choose % Transmittance from the Process menu.  The 
spectrum is converted to % transmittance units: 

 
 

 
 

Spectrum in % transmittance units 
 
 

 

 

 

The Process menu allows you to convert spectra to several other 
units as well.  These units are discussed in detail in the OMNIC on-
line Help system.  In the OMNIC Help system Index, find 
“converting spectrum” and go to the topic discussing the units to 
convert to. 
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3. Choose the Absorbance button in the toolbar. 

 
In the next section, you will label a peak in the absorbance 
spectrum using the annotation tool. 

 
 

Labeling a 
peak with the 

annotation tool  

The palette contains six tools that let you select a spectrum or spectral 
region, change how spectra are displayed in a spectral window, find the 
height or area of a peak, or label a peak.  The names and appearance of 
the palette tools indicate their functions. 
 
Follow these steps to label a peak in the polystyrene spectrum:  
 

 
1. Select the annotation tool by clicking it on the palette. 

The annotation tool in the palette lets you label peaks with their 
frequency locations (X values) or other information.   

 
 
 
 
 

      
 
 

Only one tool can be used at a time.  To use a tool, first select it 
by clicking it.  A tool remains selected until you select another 
tool.   

 

Selection Spectral cursor

Peak height

Peak area

AnnotationRegion
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When you use a tool, the readout above the palette may display 
information for the tool operation; for example, the X and Y 
values of the pointer location or the limits of the selected spectral 
region.  Here is an example of X and Y values displayed in the 
readout when the selection tool is selected: 

 
 

 
 
 

When the annotation tool is selected and you move the pointer 
into a pane of a spectral window, the pointer looks like this: 

 
 

 
 
 

You can label a peak by clicking above it with the annotation 
tool.  This displays the label text above the peak with a line 
connecting the label to the peak.  The text is selected so that you 
can immediately edit it.  When you press Enter, the label appears 
in its final form.   

 
You can more accurately locate the top of a peak by holding 
down the Shift key when you click near the peak. 
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2. Label the peak near 2,924 wavenumbers by holding down the 
Shift key and clicking a little above the peak.   

The label appears: 
 
 

 
 
 
3. Press Enter to accept the label text. 

To modify the label, edit the selected text before pressing Enter. 
To modify an existing label, select the Annotation tool and click 
the label you want to change.  Type a new label. 
 
To delete a label, select the Annotation tool and click the label.  
Then press the Delete key. 

 

 In the OMNIC Help system Index, find “tool, annotation” and go 
to the “Annotation tool” topic for more information on the 
annotation tool. 

 
 

In the next section, you will search the spectrum against a 
spectral library to identify it. 
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Searching a 
spectral library 

You already know that your sample is polystyrene, but if you were 
unsure of its composition, you could identify it by searching the 
sample spectrum against a spectral library that contains a reference 
spectrum of the same material. 
 
Follow these steps to search the sample spectrum against a spectral 
library: 
 
1. Select the polystyrene spectrum. 

 
2. Choose Library Setup from the Analyze menu.  

The Library Setup dialog box appears with the Search Libraries 
tab displayed. 
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3. Choose the directory that contains the libraries and library 
groups you want to search. 

To add a directory to the search list, choose Add Directory.  In 
the dialog box that appears, locate and select the 
C:\OMNIC\LIBS directory, and then choose OK.  The available 
libraries are added to the Available Search Libraries and Groups 
box. 
 

 
4. Add one or more libraries to the Search Libraries And 

Groups box. 

The libraries listed in the Search Libraries And Groups box are 
the libraries that your spectrum will be compared to.  Click a 
library you want to add, and then click the Add button to add it to 
the Search Libraries And Groups box. 

 
 
5. Click the Search Results tab, and then select Use Search 

Expert. 

Using the search expert saves you time because it always 
searches the region from 2600 to 450 wavenumbers.  You can 
also choose to make more specific searches by selecting 
Configure Search Results and specifying the search parameters. 

 

6. Choose Search in the Library Setup dialog box. 

You can also close the Library Setup dialog box and begin a 
library search at any time by choosing Search from the Analyze 
menu. 
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When you begin a library search, the Search window appears.  At 
the bottom of the window a gauge shows the progress of the 
search.  As library matches are found, the closest matches are 
added to the search results list in order of match value, with the 
best match listed first.  Depending on which libraries you 
selected to search, you may or may not get a good match for the 
polystyrene spectrum. 
 
Comments about the success of your search appear in the lower 
portion of the window.  You can choose View Match List to 
display a list of matches instead.  The View Match List button 
changes to the Search Expert button.  To redisplay the comments, 
choose Search Expert. 

 
 
7. Close the Search window by choosing Close. 

 

 In the OMNIC Help system Index, find “library, searching” and go to 
the “Searching a spectral library” topic for more information on 
searching spectral libraries. 
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Creating and 
printing a report 

OMNIC makes it easy to create and print a report containing the results 
of your work.  

1. Choose Template from the Report menu. 

A dialog box appears allowing you to locate and select a report 
template for the report. 

 
 
2. Go to the C:\OMNIC\REPORT directory and select the 

report template file named SEARCH1.RPT. 

This file contains a report template specially set up for this 
procedure.  The template has items for the spectral window, 
spectrum time, title and comments, and search results. 

 
When you select the report template file, a preview image of the 
template appears at the right.  This feature allows you to see what 
different templates look like so that you can pick one with the 
items you need for your report.  You can view the image as a 
graphical layout by selecting the Layout option.  This shows you 
how the printed report will look on paper.  You can also view the 
image with template items labeled by selecting the Description 
option.  This lets you identify items that are too small to be seen 
clearly. 

 
 
3. Choose Select to make the example template the current 

template for printing reports. 

When you print your report, OMNIC will automatically fill in the 
items in the template with the appropriate information and 
images.  For example, if an item in the template is linked to the 
active spectral window, the contents of that window appear on 
paper when you print the report 
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You can create your own report templates by using the Create 
button, or you can modify one of the existing templates whenever 
you want to design a new template.  Save the template with a new 
name after you make your changes.  In the OMNIC Help system 
Index, find “report template, selecting” and go to the “Selecting, 
editing or creating a report template” topic for more information on 
using reports. 

 
 
4. Choose Preview/Print Report from the Report menu. 

A preview of the report appears showing the report items filled in 
with information about your spectrum.  Your report should look 
similar to this: 

 
 

  
 
 

The preview lets you check the content of the report before 
printing it. Choose the Zoom button to see an enlarged image of 
the report. 
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5. If you have a printer connected to the computer, choose Print 
to print the report. 

The Print dialog box appears allowing you to set some 
parameters that affect printing. 

 
 
6. Choose OK. 

The report is printed on your system printer. 
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Adding the 
spectrum to 

a user library 

You can save your spectrum in a user library even if you have saved it 
in a spectral data file.  This allows you to find the spectrum later by 
searching for text contained in the information saved with the 
spectrum.  If you add your own reference spectra collected from pure 
sample materials to a user library, you can also use the library to 
identify unknown spectra. 
 
Follow these steps to add the polystyrene spectrum to a user library: 

 
1. Select the polystyrene spectrum. 

 

 
2. Choose the Add To Library button on the toolbar. 

You can also choose Add To Library from the Analyze menu.  The 
Select Library dialog box appears listing all the user libraries 
available in the currently specified library directories of the hard 
disk.   
 

 
3. Select the User Example Library. 

This library has been created for you to use in this example. 
 
 
4. Choose OK. 

The Add To Library dialog box appears showing the name of the 
library you selected and the index number that has been assigned 
to the spectrum.  The dialog box also contains fields into which 
you can enter information about the spectrum.  The first field 
already contains the compound name.  You can accept or change 
the text in the fields. 

 
 
5. When you have finished entering information about the 

spectrum, choose OK. 

 



 

Magna-IR 560 and 760 User’s Guide       55 

You can also add a spectrum to a library by dragging the spectrum or 
the spectrum’s file to the library’s book on the Library Names tab of 
Library Manager. 
 

 In the OMNIC Help system Index, find “user library, adding a 
spectrum to” and go to the “Adding a spectrum to the user library” 
topic for more information on options for adding spectra to libraries.  
 
 

Creating a  
user library 

Creating your own library lets you customize the information in the 
library depending on your search needs.  You can create a search 
library, QC library or scrapbook library. 
 
When you create a user library, you determine the kinds of 
information that will be saved with it.  You also set a number of 
parameters, including the resolution and spectral range of the library 
and which checks and corrections are performed.  The Library 
Creation Wizard leads you through the steps that are appropriate for 
the type of library you are creating. 
 
Once a library is created, you can add spectra to it with the Add To 
Library button (or with Add To Library in the Analyze menu) and 
use it just as you would a commercial library to identify unknown 
spectra or verify the composition of a sample.  If you create a 
scrapbook library, you can find spectra in it by searching for text.  In 
this example you will create a new search library. 
 
1. Choose Library Manager from the Analyze menu. 

Library Manager appears with the Library Names tab in front. 
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2. Choose Create Library. 

The Library Creation Wizard appears.  For this example we will 
create a new search library. 
 

 

 
 

3. In the Library Creation Wizard, select Search Library, and 
then enter a name and filename. 

The name you enter for the library will appear in the Library 
Names list when you add a spectrum to a library.  You can enter 
a new filename or accept the default name the Wizard assigns.  
Click Next to continue. 
 
 

4. In the next dialog box, enter any comments you wish to 
record and your name. 

The comments you enter will appear in the Comments box on the 
Library Info tab of Library Manager when you select the library 
on the Library Names tab.  The name you enter will appear in the 
Created By readout on the Library Info tab when you select the 
library on the Library Names tab.  
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5. Add more information about your library. 

You can continue entering information about the new library by 
clicking Next.  The Wizard lets you enter information about 
spectral range, resolution and blanked areas for searching.  For 
this example, click Next in each window. 

 
 
6. When you have completed entering information, click Finish. 

When you click the Finish button, your library is created.  You 
can see your library listed by clicking the Search Libraries book 
on the Library Names tab. 

 

 In the OMNIC Help system Index, find “library, creating” and go 
to the “Creating a user library” topic for more information on 
library creation.  
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  Spectrometer Basics 
 
 
 

This chapter describes the major components of your spectrometer, 
including the light source, beamsplitter and detector.  It then explains 
what you will need to know before collecting data in various spectral 
ranges. 
 

 View the “From the front,” “The back panel,” and “Inside the 
spectrometer” units of the “Spectrometer Tour” tutorial for complete 
descriptions of your spectrometer’s internal and external components. 
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Major 
spectrometer 
components 

The following illustration and table identify the major components of 
the System 760 spectrometer.  The System 560 is identical except that 
it has a single door for filling a detector dewar, in the front position, 
and does not have a detector access hatch* or beamsplitter 
compartment hatch. 

 
 

 

1

2

3

4
5

6

7

8

9
1011

12

13

 
 

                                                 
* The detector access hatch is available as an option on the System 560. 
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Number Description 
 

1 Access doors for filling the detector dewars with liquid 
nitrogen. 

  
2 Front panel with Power, Scan, Laser and Source indicator 

lights. 
  

3 Purge shutters for sealing off the sample compartment when 
you install a sample. 

  
4 Electronics cover. 
  

5 Beamsplitter compartment hatch. 
  

6 Emission port for an external source. 
  

7 External beam port. 
  

8 Desiccant area (under the sample tray) for holding the 
desiccant (in sealed and desiccated systems only). 

  
9 Sample tray for holding samples and other items needed for 

your experiments. 
  

10 Beam ports (behind the snap-on cover) for special 
applications such as the integrated SabIR accessory. 

  
11 Sample compartment cover. 

  
12 Sample compartment sliding door for installing samples. 

  
13 Detector compartment access hatch. 

 

 
 

 ▲ Caution To avoid overheating of electronic components, do not place 
anything on top of the electronics cover of the spectrometer. ▲ 
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What’s inside? The illustration below shows a top view of the optical layout of the 
System 560 or 760 spectrometer with covers removed to reveal 
components.  See the table that follow for identifications of the 
numbered components.  The dashed line containing arrows shows the 
path of the infrared beam. 
 
 

DO NOT STARE INTO BEAM 
OR VIEW DIRECTLY WITH 
OPTICAL INSTRUMENTS.

5 mW HeNe Laser CLASS IIIA LASER 
 

CAUTION

Laser radiation when open  

and interlocks defeated.

Do not stare into beam or  

view directly with optical  

instruments.

CAUTION

1 2 3 4 6 7

8
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25
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5

24  
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Number Description Number Description 
 

1 Interferometer 16 Near-IR source (optional; requires 
quartz or CaF2 beamsplitter) 

2 Laser 17 SabIR fiber optic detector port 
(optional) 

3 Moving mirror 18 Special detector mounting pad 

4 Beamsplitter 19 Seaport external beam port 

5 Fixed mirror 20 Sample focus mirror 

6 Beamsplitter latch 21 Sample compartment 

7 Beamsplitter storage area 22 Sample holder 

8 Parabolic mirror or optional Import 
emission optics 

23 Energy screen or filter (optional) 

9 External emission source port 24 Optional port for far-IR bolometer 
detector 

10 Passport optics (optional) 25 Front detector location 

11 Right-side external beam port 26 Monoflect detector mirror 

12 Aperture 27 Back detector location 

13 Ever-Glo IR source 28 Left-side external beam port 

14 Source selection mirror (optional) 29 Power supply 

15 Source focus mirror   
 

 
 

 View the “Inside the spectrometer” unit of the “Spectrometer Tour” 
tutorial for complete descriptions of your spectrometer components. 
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What is on 
the rear panel? 

The following illustration shows the locations of the connectors, purge 
input, fuses and power switch on the spectrometer rear panel: 

 
 

Power switch

AC power connector

Purge input

Accessory 
detectors

Remote signals 
accessory

Computer

Accessory controlAccessory control

Accessory pass-through 
connectors

Fuses

Auxiliary 1 Auxiliary 2

 
 
 

 View “The back panel” unit of the “Spectrometer Tour” tutorial for 
complete descriptions the rear panel components. 
 
For descriptions of the Accessory pass-through connectors, see the 
“How to cable an accessory” section of the “Accessories You Can Buy 
and How to Install Them” chapter of this manual. 
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Turning on the 
spectrometer power 

To turn on the spectrometer, press the power switch (|/O) on the rear 
panel to |.  To turn the spectrometer off, press the switch to O.  The 
following illustration shows the location of the power switch: 
 
 

Auxiliary 1 Auxiliary 2

 
 
 

   Warning Do not operate the spectrometer without following the safety 
precautions described in this manual and in the Optical Bench Safety 
Guide that came with your system. ▲ 

 

 View the “Powering Up” unit of the “Spectrometer Tour” tutorial for 
complete instructions on turning on your system. 
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 Note After you turn on the spectrometer, let it stabilize for 15 minutes 
(one hour for best results) before collecting data.  Leave the 
spectrometer on at all times, unless the building is subject to power 
outages or you need to perform a service or maintenance procedure.  
Leaving the spectrometer on increases stability and consistency of 
performance. ▲ 

 
 ▲ Caution To avoid overheating the electronic components, do not place 

anything on top of the electronics cover (left-rear cover) of the 
spectrometer.  See the first illustration in this chapter for the location 
of the cover. ▲ 
 
When you turn on the spectrometer, the four indicators on the front 
panel—Power, Scan, Laser and Source—flash in various sequences 
as the system runs through its diagnostic routines.  When the 
routines are finished, the Power, Laser and Source indicators stay 
lighted.  The Scan indicator flashes with each scan of the 
interferometer. 
 

 Note The system enters a “long-stroke” mode 10 minutes after data 
collection activity has ceased.  This mode continues for 1 hour.  
After 1 hour, the interferometer stops scanning and the scan light 
stays on.  Any data collection activity will cause the interferometer 
to begin scanning.  Exiting OMNIC also activates the long-stroke 
mode. ▲ 

 
 Note If the Power, Laser or Source indicators flash or will not light at all, 

or if the Scan indicator will not light, the Bench Status indicator will 
show a red X and troubleshooting tips will appear on the OMNIC 
screen.  If you cannot resolve the problem, contact Nicolet at one of 
the numbers below.  Outside the U.S.A. call your local sales or 
service representative.  Telephone numbers for all Nicolet Customer 
Support offices are provided with your system. 
 
• Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538) 
• Fax: 1-608-273-6045 
• World Wide Web: http://www.nicolet.com 
• E-mail: nicinfo@nicolet.com ▲ 
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Using a light source The System 560 and 760 spectrometers are available with a single 
internal source or with optional dual sources.  If your spectrometer 
does not have the dual-source option, you will need to change sources 
in order to use a different internal source. 
 

 If you need to install or change a source, choose Replacing Parts from 
the OMNIC Help menu and view the “Changing a Source” tutorial in 
the “Replacing parts” book. 
 

   Warning Even after the spectrometer is turned off, the external housings of 
working IR sources remain hot for up to 15 minutes.  To avoid being 
burned by a currently installed source, allow enough time for it to 
cool before handling it. ▲ 
 
If your spectrometer has the dual-source option, you can use a 
different internal source by simply changing the Source setting on 
the Bench tab of the Experiment Setup dialog box.  This option lets 
you collect data in the mid-IR to far-IR range or in the visible to 
near-IR range.  The spectral range is determined by the source you 
are using and by the selected detector and beamsplitter.   
 
System 560 and 760 spectrometers with the emission accessory can 
use an external source if one is available.  The beam from the 
external source passes through the emission port on the right side of 
the spectrometer. 
 

 In the OMNIC Help system Index, find “source” and go to the 
“Specifying the source type” topic for instructions on using different 
sources in spectrometers with single sources and with dual sources. 
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Using 
beamsplitters 
and detectors 

A number of beamsplitters and detectors are available for use in the 
System 560 and 760.  Not all beamsplitters and detectors can be used 
together.  Some detectors can accommodate only a portion of the 
energy from the source and require changing the aperture size or 
installing an energy filter.  This chapter explains how to select and 
optimize the performance of beamsplitters and detectors. 
 

 If you need to install or change a beamsplitter or detector, choose 
Replacing Parts from the OMNIC Help menu and view the appropriate 
tutorial in the “Replacing parts” book. 
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Selecting the right 
beamsplitter and detector 

There are two considerations when selecting a beamsplitter-detector 
combination:  compatibility and spectral range. 
 
The following table shows which combinations perform best and 
which are compatible.  Combinations are considered compatible if they 
provide a detector signal that is large enough to allow the beamsplitter 
to be aligned.  This does not necessarily mean a particular beamsplitter 
and detector combination will provide the maximum capable 
sensitivity range of each component. 
 
 

BEAMSPLITTER

DETECTOR Quartz CaF KBr CsI
Solid 

     Substrate™ 2

Far-IR
Mid-IRNear-IR

DTGS 
(KBr window)*

DTGS 
(CsI window)

DTGS 
(PE window)† 

MCT-A

MCT-B

InSb

PbSe

Si‡ 

X OK XOK Best

X Best XX OK

X OK BestX X

OK OK XOK Best

OK OK XOK Best

OK X XBest X

OK X XBest X

Best X XOK X

XT-KBr

Best

OK

X

Best

Best

OK

OK

X

PbS§ OK X XBest XX
 

Best = Optimum beamsplitter-detector combination. 
OK = Compatible beamsplitter-detector combination. 
X = Incompatible beamsplitter-detector combination. 
 

* Valid for room temperature and thermoelectrically cooled versions. 
† These detectors are typically set up for optimum performance using a Gain setting of 4.  
‡ Can be used only with the white light source. 
§ Can be used only with the SabIR accessory. 
 

The next table lists the spectral ranges of compatible beamsplitter-
detector combinations. 
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Light Range Beamsplitter Detector    Spectral Range (cm-1) Source 
 

visible quartz PbSe 13,000 - 2,800* Ever-Glo, white light 
  Si† 25,000 - 8,600 White light 
 

 CaF2 PbSe 13,000 - 2,000* Ever-Glo, white light 
  Si† 14,500 - 8,600 White light 
 

near-IR quartz MCT-A‡ 11,700 - 2,800* Ever-Glo, white light 
  MCT-B‡ 11,700 - 2,800* Ever-Glo, white light 
  InSb‡,§ 11,500 - 2,800* Ever-Glo, white light 
  PbSe 13,000 - 2,800* Ever-Glo, white light 
  PbS TEC (with SabIR)  10,000 - 4,200* Ever-Glo, white light 
 

 CaF2 MCT-A‡ 11,700 - 1,200* Ever-Glo, white light 

  MCT-B‡ 11,700 - 1,200* Ever-Glo, white light 
  InSb‡,§ 11,500 - 1,850* Ever-Glo, white light 
  PbSe 13,000 - 2,000* Ever-Glo, white light 
  PbS TEC (with SabIR)  10,000 - 4,200* Ever-Glo, white light 
 

 XT-KBr MCT-A‡ 11,000 - 600* Ever-Glo, white light 
  MCT-B‡ 11,000 - 400* Ever-Glo, white light 
  InSb‡,§ 11,000 - 1,850* Ever-Glo, white light 
  PbSe 11,000 - 2,000* Ever-Glo, white light 
  DTGS-KBr 11,000 - 375* Ever-Glo, white light 
  DTGS TEC 11,000 - 375* Ever-Glo, white light 
 

mid-IR KBr DTGS-KBr 7,400 - 350 Ever-Glo 
  MCT-A‡ 7,400 - 600 Ever-Glo 
  MCT-B‡ 7,400 - 400 Ever-Glo 
  DTGS TEC 7,100 - 350 Ever-Glo 
  DTGS-CsI 6,400 - 350 Ever-Glo 
 

 CsI¶ DTGS-CsI 6,400 - 200 Ever-Glo 
  MCT-A‡ 6,400 - 600 Ever-Glo 
  MCT-B‡ 6,400 - 400 Ever-Glo 
 

far-IR Solid-Substrate DTGS-PE 700 -  50 Ever-Glo 
 

Notes: 
* This spectral range reflects the combination of the ranges of the Ever-Glo and white light sources, as well as the limits of the 

beamsplitter-detector combination.  The range achieved using one of these sources will not be as broad as the total range shown. 
† Si detectors can be used only with a white light (tungsten-halogen) source. 
‡ These detectors must be cooled with liquid nitrogen before use. 
§ InSb detectors will not produce a signal under intense light.  During installation and alignment, start with the smallest aperture setting. 
¶ CsI beamsplitters are extremely hygroscopic (sensitive to moisture). 
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Optimizing the 
performance 

of your detector 

Magna-IR detectors can be optimized to produce a more linear 
response and greater photometric accuracy, or to increase the 
signal-to-noise ratio.  These improvements in performance are each 
accomplished by adjusting the amount of infrared energy that reaches 
the detector. 
 
 

Improving linearity and 
photometric accuracy 

Some detectors (including Si, PbSe, MCT-A and InSb detectors) are 
highly sensitive and can become saturated or produce a distorted (non-
linear and photometrically inaccurate) signal if the light energy is not 
reduced before it reaches the detector element. 
 
Look at the low-end region of a single-beam spectrum (below the 
low-end cutoff); you should see a straight line very near 0.  As a rule 
of thumb, the distance from 0 to the baseline should be less than 1% 
of the spectrum’s maximum intensity value.  If the detector is 
saturated, you will see false energy in the low-end region.  The 
baseline might be far above zero.   
 

 Note The maximum intensity of a mid-IR single-beam spectrum is 
typically found near 2,000 cm-1. ▲ 
 
The distorted signal may cause problems with photometric accuracy.  
For good quantitative data, the sample and background 
interferograms should be about the same size.  Scattering samples 
and very dense samples produce very small signals that, when 
compared with much larger background signals, can distort 
quantitative data. 
 
Check the low-end region or the background and sample 
interferograms.  If you see a substantial difference in their size, 
photometric accuracy could be a problem. 
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To solve these problems, Magna-IR spectrometers allow the 
following options for modifying the infrared beam: 
 
• Install a bandwidth-limiting filter. 
• Install an energy screen. 
• Change the aperture setting. 
 

 See “Setting up for experiments” available through Installing 
Hardware in the Help menu for instructions on installing filters and 
energy screens.  In the OMNIC Help system Index, find “aperture” and 
go to the “Setting the aperture size” topic for information on changing 
the aperture setting. 
 
In most cases, system performance will be better if you use a filter or 
screen instead of reducing the aperture size.  The filter or screen that 
you should use for your application depends on the samples being 
measured and other experimental conditions.  Try using various 
filters or screens to determine which give the best results for your 
application. 
 
 



 

Magna-IR 560 and 760 User’s Guide       73 

When to use 
bandwidth-limiting filters 

Nicolet offers several optional bandwidth-limiting filters for 
optimizing performance in the spectral range that they pass.  These 
filters improve the signal-to-noise ratio of the data and also prevent 
detector saturation by allowing only energy in your particular area of 
interest to pass to the detector element. 
 
The following table lists the bandwidth-limiting filters available 
from Nicolet and indicates the band of energy that each filter passes.  
(Filters from other manufacturers that have the same optical 
characteristics can be used instead.) 
 
 

Filter Band Passed by Filter Typical Use 
 

polyethylene 700 - 50 cm-1 far-IR 
   
red 16,000 - 9,000 cm-1 near-IR  
   
broad-band blue 23,000 - 16,000 cm-1 visible 
   
narrow-band blue 26,000 - 21,000 cm-1 visible 
 

 
 

 See “Setting up for experiments” available through Installing 
Hardware in the Help menu for instructions on installing filters. 
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When to use energy screens Depending on the types of detectors you use, your system may include 
a set of four energy screens.  These metal screens help prevent detector 
saturation and signal distortion by blocking out a portion of the energy 
at all frequencies of the infrared beam.  If your experiments deal with 
information from a broad range of frequencies, these screens may be 
the most effective means of reducing the light level.  In most cases 
system performance will be better if you use an energy screen instead 
of reducing the aperture size. 
 
The energy screens are labeled A, B, C and D.  The following table 
shows the percentage of the infrared energy that each screen passes.  
It also lists the detectors typically used with each screen, as a starting 
point for correcting linearity problems. 
 
 

Screen % Transmitted* Detectors Typically Used With Screen 
 

 none 100 DTGS, MCT-B 

   A 30 MCT-A, InSb 

   B 10 Si, PbSe 

   C 3  

   D 1 
 
* These are nominal values that may vary due to diffraction and detector variations. 
 

 
 

To correct for photometric accuracy, you may need to add a 
“heavier” screen (one that transmits less infrared energy).  With 
corrections for photometric accuracy you will notice some reduction 
in the signal-to-noise ratio but will obtain more reliable quantitative 
data.  Generally, the signal-to-noise ratio is reduced less than is the 
signal intensity. 
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 See “Setting up for experiments” available through Installing 
Hardware in the Help menu for instructions on installing energy 
screens. 
 

 
What aperture size to 
use for your detector 

The aperture is a variable-diameter opening which controls the angular 
size of the infrared beam and, thus, the amount of radiation that 
reaches the sample.  Using an aperture provides the following 
advantages: 
 
• It lets you use more sensitive detectors. 
 

• It helps prevent infrared energy saturation, so the response of the 
detector is more linear. 

 

• It improves wavenumber accuracy and resolution by acting as a 
point source of infrared radiation. 

 
In general you will find that the larger the aperture, the better is the 
signal-to-noise ratio of the collected data.  The smaller the aperture, 
the better the stability and accuracy will be.  Small apertures are 
needed for high-resolution experiments. 
 
DTGS detectors can accommodate most of the energy from the 
source, which means you should use a large aperture size.  Detectors 
that require cooling with liquid nitrogen are very sensitive and 
require a small aperture size or the use of an energy screen (see the 
preceding section for more information). 
 

 Note On Magna-IR spectrometers, the setting of the Aperture parameter 
determines the area of the aperture opening.  Doubling the setting 
approximately doubles the area.  A setting of 100 gives a nominal 
aperture size of 8 mm and an approximate area of 0.50 cm2. ▲  
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The following table lists recommended aperture settings for different 
detectors with the appropriate energy screen installed.  (See the 
preceding section for information on the correct energy screen to use 
for each detector type.)  The settings in the table are based on the 
physical size of the detector elements and maximize the amount of 
infrared energy that reaches the sample.  To correct linearity and 
photometric accuracy problems, you can reduce the setting, but you 
will pay a price in terms of signal-to-noise ratio.  
 
 

Detector Aperture Setting 
 

DTGS 100 

MCT-A, MCT-B, InSb, PbSe, Si 32 
 

 

 

 In the OMNIC Help system Index, find “aperture” and go to the 
“Setting the aperture size” topic for information on changing the 
aperture setting. 
 
 

How to improve the 
signal-to-noise ratio 

If you primarily analyze qualitative data, you may wish to optimize the 
system for a better signal-to-noise ratio.  This can be particularly 
important when you are working with scattering samples and samples 
that absorb more infrared energy.  These samples produce smaller 
signals that can be “lost” in the noise. 
 
There are several ways to improve the signal-to-noise ratio.  The 
most commonly used method is to increase the number of scans.  
This both reduces the noise level and makes small absorptions easier 
to distinguish.  You can also improve the ratio by reducing the 
resolution (using a larger Resolution setting). 
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Other methods can be used with sensitive detector types.  These 
include using an energy screen that transmits more light (or no 
screen at all) or increasing the aperture setting.  With either of these 
corrections, the resulting spectrum might be distorted and accuracy 
and stability could be reduced.  Checking the single-beam baseline in 
the region below the low-end cutoff will give you a rough idea of 
how much distortion is occurring.  If the distance from the baseline 
to 0 is more than 15% of the spectrum’s maximum intensity value, 
you may have difficulty reproducing the results. 

 
 Note If the distance from the baseline to 0 is greater than 20% of the 

spectrum’s maximum intensity value, your detector electronics may 
be overloaded.  Contact Nicolet Customer Support for assistance. ▲ 
 

 See “Setting up for experiments” available through Installing 
Hardware in the Help menu for instructions on installing filters and 
energy screens. 
 
 

How to improve  
the resolution 

If you want to achieve higher resolution, you may need to use a smaller 
aperture setting and an energy screen that transmits more light (or no 
screen at all).  Your spectroscopy software will automatically change 
the aperture setting if a smaller beam size is required.  Be aware that 
the smaller beam size will reduce the signal-to-noise ratio. 
 

 In the OMNIC Help system Index, find “aperture” and go to the 
“Setting the aperture size” topic for information on changing the 
aperture setting. 
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How to collect 
data in the visible 

spectral range 

The ability of the spectrometer to collect data is affected by the 
detector-beamsplitter combination and any energy screens or optical 
filters that are installed in the spectrometer.  For example, if you use an 
optional quartz beamsplitter, a silicon detector and a white-light 
source, the sampling range is extended to 25,000 cm-1. 
 
Since silicon detectors are very sensitive, you will also need to install 
an energy screen or bandwidth-limiting filter to prevent the detector 
from being saturated during the experiment.  The following table 
lists a variety of spectral bands in the extended spectral range and 
lists the filter or energy screen that should be used to obtain data in 
each range.  It also lists typical aperture and gain settings for 
experiments in each range. 
 
 

Spectral Range Filter or Screen Aperture Gain 
 

16,000 - 9,000 cm-1 red filter 32 1 

16,000 - 9,000 cm-1 energy screen A 32 1 

23,000 - 16,000 cm-1 broad-band blue filter 100 8 

26,000 - 21,000 cm-1 narrow-band blue filter 100 8 
 

 
 
You can use these filters and settings as a starting point and vary 
them as required by your experimental conditions.  To set aperture 
and gain, set the Aperture and Gain parameters on the Bench tab in 
the Experiment Setup dialog box. 
 

 See “Setting up for experiments” available through Installing 
Hardware in the Help menu for instructions on installing filters. 
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About the moving 
mirror velocity 

While a wide range of moving mirror velocities is available on the 
System 560 and 760, some velocity settings cannot be used for 
collecting data at certain combinations of spectral range and resolution:
 
• If you are collecting data over a spectral range below 7899 cm-1 

and at a resolution better than 2.0 cm-1, do not use a velocity 
faster than 5.06 cm/sec. 

 
• If you are collecting data over a spectral range above 7899 cm-1, 

do not use a velocity faster than 2.53 cm/sec. 
 
To specify the velocity and spectral range, use the Velocity and 
Spectral Range settings on the Bench tab in the Experiment Setup 
dialog box. To specify the resolution, use the Resolution setting on 
the Bench tab. 
 

 Important When you switch to a different detector or beamsplitter, OMNIC 
automatically resets the default spectral range in the Experiment 
Setup window.  Be sure to check the range and set the velocity to a 
value that is appropriate (see the limitations described above). ▲ 
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  Accessories You Can Buy and 
How to Install Them 

 
 
 

This chapter briefly describes the types of sampling and system 
accessories that are available for your spectrometer.  Complete 
descriptions and operating instructions are included with the 
accessories. 
 
 

Sampling 
accessories for 

different applications 

You can install many of the sampling accessories yourself.  After you 
install an accessory, you might have to align it.  Instructions for 
aligning the spectrometer are included in the “Service and 
Maintenance” chapter of this manual.  Instructions for aligning an 
accessory are provided in the documentation that came with that 
accessory. 
 
Most accessories fit into the sample compartment, but some require 
separate housing and optics.  Nicolet offers auxiliary experiment 
modules, microscopes, gas chromatography interfaces, liquid 
analysis systems, and SabIR fiber optics with the System 560 and 
760.  A Raman accessory is also available for the System 760. 
 
Some accessories have their own optics.  The optional Passport 
optics inside the spectrometer redirect the light beam from the 
internal light source through a port on the right or left side of the 
spectrometer.  The beam then travels into the accessory’s optics.  
The Seaport option redirects the IR beam from the sample 
compartment to the front port position. 
 



82       Nicolet 

The collimated light beam from an accessory that includes its own 
external source can be directed into the System 560 or 760 optics 
through a port on the right side or front of the spectrometer.  Using 
the port on the right side of the spectrometer requires a detector in 
the front or back detector location.  Using the port on the front of the 
spectrometer requires an optional emission detector in the front-right 
detector location below the sample tray. 
 

 

 

 

Some of the accessories fit into the sample compartment and require 
that you remove the standard Snap-In baseplate before installing the 
accessory.  For instructions on using Snap-In baseplates, choose 
Replacing Parts from the OMNIC Help menu.  Then choose the 
“Removing the snap-in baseplate” topic from the “Replacing parts” 
book. 
 
Call Nicolet if you are interested in ordering any of the following 
sampling accessories. 
 

 Note Additional Snap-In sample compartment baseplates are available for 
use with each accessory to make changing accessories easier. ▲ 

 
ATR needle probe and FiberLink™ – This high-throughput 
accessory lets you analyze liquids remotely.  The needle probe can 
reach “hard to get” samples, such as liquids in micro containers, 
hazardous environments or remote locations.  The FiberLink is a 
unique optical interface that transfers IR energy from the 
spectrometer to the fiber optic cables and probes.  A complete line of 
fiber optic probes is available for sampling a wide range of sample 
types. 
 
Attenuated total reflection (ATR) – Attenuated total reflection 
accessories are used to sample highly absorbent solid and liquid 
materials, including surface films, coatings, polymers, powders and 
adhesives.  These accessories can be installed in the main 
spectrometer sample compartment or in an auxiliary experiment 
module (AEM). 
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Attenuated total reflection kit (The A.R.K.™) – The A.R.K. is a 
horizontal ATR accessory with high stability, complete purge 
capabilities, tool-free alignment and high performance specifications.  
It includes integral purge tubes that seal the accessory from the 
atmosphere, and an aluminum, cast body for exceptional stability. 
 
The A.R.K. is also available as an E.S.P. accessory.  E.S.P. 
accessories are automatically recognized by the Magna-IR E.S.P. 
spectrometer and OMNIC E.S.P. software.  The system 
automatically selects the correct operating parameters for the system 
when the A.R.K. E.S.P. is installed.  Also, a series of spectral quality 
checks are performed to ensure that the accessory is installed and 
operating correctly. 
 

 For instructions on installing E.S.P. accessories, choose Replacing 
Parts from the OMNIC Help menu.  Then choose the “Installing 
optional hardware” topic from the “Replacing parts” book. 
 
Automatic sample wheel – This accessory holds multiple samples  
and rotates them into the beam path for data collection.  The sample 
wheel is commonly used to measure multiple polymer or pressed-
powder samples automatically. 
 
Auxiliary experiment  module (AEM) – The auxiliary experiment 
module (AEM) provides you with an additional sample 
compartment.  The AEM can be positioned on either side of the 
spectrometer.  With an AEM installed, you can run routine analyses 
with the spectrometer and quickly switch beam paths to the AEM to 
collect data from other samples without removing accessories from 
the main sample compartment.  Any accessory or detector that can 
be installed in the spectrometer can be installed in the AEM.  The 
AEM has two detector locations. 
 



84       Nicolet 

Detector interface kit – A variety of accessories (that were 
specifically designed for Protégé 460 spectrometers) contain 
detectors that are automatically recognized by your spectrometer.  
The detector interface accessory allows your spectrometer and 
OMNIC software to recognize other detectors, including non-Nicolet 
detectors. 
 
Diffuse reflection – Diffuse reflection enables analysis of highly 
light-scattering solids that are difficult to analyze using transmission 
techniques.  This method is also useful when the sample, usually a 
powder, must be analyzed without modification.  Diffuse reflection 
accessories can be installed in the spectrometer sample compartment 
or AEM. 
 
Fiber optics – The SabIR fiber optic accessory is optimized for near-
IR sampling.  The probe combines input and collection fibers in a 
unique sampling tip.  In reflectance mode, solids and light-scattering 
liquids can be analyzed through direct contact.  Transflectance mode 
is used for transparent liquids.  This accessory is useful for the 
nondestructive study of polymers, pharmaceuticals, foods, fabrics 
and chemicals, as well as biological and environmental samples.  
The accessory uses an optimized lead sulfide detector and is 
available in versions that can be mounted in the sample compartment 
or in the front-right detector location below the sample tray.  Mid-IR 
fiber optic accessories are available for mounting in the sample 
compartment. 
 
Gas cells – A variety of short- and long-pathlength gas cells are 
available.  Cells include built-in transfer optics that fit into your 
spectrometer or AEM sample compartment.  The cells are suitable 
for use in both ambient and elevated temperature conditions.  Gas 
cell heating, transfer optics purge, gas manifold, and sample window 
options are available to accommodate a variety of sample gases and 
sampling conditions. 
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GC interface – This interface attaches to the right side of the 
spectrometer and must be connected to a gas chromatograph (GC).  
You can then analyze IR spectra from GC experiments using the 
OMNIC Series software. 
 
Gemini – By combining two sampling technologies—horizontal 
attenuated total reflection (HATR) and diffuse reflection—this 
accessory lets you analyze a broad range of sample types.  The 
Gemini is baseplate-mounted for high stability, and no accessory 
realignment is necessary when you switch sampling heads.  Integral 
purge tubes seal the accessory from the atmosphere. 
 
IR microscopes – Nicolet offers microscopes that attach directly to 
either side of the spectrometer.  Microscopes can also be installed 
between the spectrometer and other accessory modules.  The 
microscopes provide fast, nondestructive microanalysis with 
minimal sample preparation and alignment.  The beam path is 
switched from the spectrometer to the microscope module through 
the OMNIC software.  
 
Liquid analysis system – The Nicolet Liquid Analysis System lets 
you collect and process quantitative analysis data for liquid samples.  
The System uses the OMNIC Integra™ software, which contains 
methods designed for quantifying components in specific types of 
liquids.  The System can include a Programmable Liquid Uptake 
System (PLUS™) and an autosampler for automating liquid sample 
handling. 
 
ProfilIR® – This accessory lets you perform automated, variable-
angle, attenuated total reflection and external reflection experiments.  
Special cabling is required. 
 
Raman – The Raman accessory can be attached to the right side of a 
Magna-IR 760 spectrometer and used with Nicolet’s OMNIC For 
Raman software to collect and process FT-Raman spectral data.  The 
accessory includes an excitation laser and a sample compartment.  
Several sampling configurations are available. 
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Start accessory – The Start Accessory adds external trigger 
capability to your spectrometer.  With a press of the Start switch, you 
can control the start of data collection or coordinate the start of an 
external experiment.   
 
Sample shuttle – A sample shuttle lets you collect background 
spectra without removing the sample from the sample compartment.  
The shuttle automatically moves the sample out of the beam path 
before background collection begins.  Since the sample compartment 
cover is not opened, the system purge is maintained. 
 
Single Bounce Horizontal ATR (SB-HATR) – The SB-HATR 
accessory has a shorter pathlength and higher throughput than 
traditional horizontal ATR accessory design.  It is the best choice for 
routine analysis of strong infrared-absorbing samples. This is an 
economical choice for quality control or academic environments 
where routine analyses of neat solvents, aqueous solutions, powders 
and film samples are required. 
 
The SB-HATR is also available as an E.S.P. accessory.  E.S.P. 
accessories are automatically recognized by the Magna-IR E.S.P. 
spectrometer and OMNIC E.S.P. software.  The system 
automatically selects the correct operating parameters for the system 
when the SB-HATR E.S.P. is installed.  Also, a series of spectral 
quality checks are performed to ensure that the accessory is installed 
and operating correctly. 
 

 For instructions on installing E.S.P. accessories, choose Replacing 
Parts from the OMNIC Help menu.  Then choose the “Installing 
optional hardware” topic from the “Replacing parts” book. 
 
Specular reflection – Specular reflection provides a nondestructive 
method for measuring surface coatings without sample preparation.  
It can be used to analyze surface-treated metals, paints, 
semiconductors, and resin and polymer coatings.  Specular reflection 
accessories can be installed in the spectrometer sample compartment 
or AEM. 
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TGA interface – This interface is equipped with a built-in, 
temperature-controlled flow cell and must be connected to a 
thermogravimetric analysis (TGA) furnace.  You can then analyze 
the evolved gases from TGA experiments using the OMNIC Series 
software.  The TGA interface is usually mounted in the sample 
compartment of an AEM. 
 
Transmission – Transmission is the oldest and most efficient 
sampling technique in FT-IR spectroscopy and can be used for 
sampling liquids, gases or solids.  A variety of cells and sample 
holders are available for transmission analysis.  All can be mounted 
in the spectrometer sample compartment or an auxiliary experiment 
module. 
 
The standard transmission baseplate is also available as an E.S.P. 
accessory.  E.S.P. accessories are automatically recognized by the 
Magna-IR E.S.P. spectrometer and OMNIC E.S.P. software.  The 
system automatically selects the correct operating parameters for the 
system when the Transmission E.S.P. baseplate is installed.  Also, a 
series of spectral quality checks are performed to ensure that the 
baseplate is installed and operating correctly. 
 
Validation wheel – The validation wheel is used with Nicolet’s 
System Validation software to validate the performance of the 
spectrometer.  The wheel automatically moves standard samples into 
the beam path at the appropriate times during the validation 
procedure. 
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System accessories Some system accessories are installed by Nicolet.  Call Nicolet if you 
are interested in ordering any of the following accessories. 
 
Power line conditioner – Power line conditioners protect your 
spectrometer and other accessories from damage or malfunction due 
to voltage dropouts, transient spikes, frequency shifts or other 
disturbances in your electrical service. 
 
Uninterruptable power supply – An uninterruptable power supply 
reduces the chance of a system shutdown if power is lost elsewhere 
in the building. 
 
Pure air generator – Nicolet offers a complete dry-air generation 
system.  It includes an air compressor, a dryer, prefilters, a final 
filter/moisture indicator, and flow controls.  If you have difficulty 
controlling moisture in your laboratory, the pure air generator 
provides additional protection for the hygroscopic elements of your 
spectrometer.  This accessory is also useful if your laboratory 
environment is contaminated with volatile solvents, oil or other 
reactive materials. 
 
Purge gas generator – If you do not have in-house facilities to 
supply compressed air or nitrogen for system purge, Nicolet offers 
several purge gas generators.   
 
RSVP Remote diagnostics – This option uses a data modem and 
remote control software to allow control of your computer (and 
spectrometer) through the modem link.  An analog telephone line is 
required.   
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How to cable 
an accessory 

When you install an accessory in the sample compartment, you may 
need to connect one or more cables from the accessory to connectors 
on the rear wall of the compartment.  You may also need to attach 
cables from other peripherals (such as computers, custom controllers or 
power supplies) to the accessory or from the accessory to the rear panel 
of the spectrometer.  The instructions that came with the accessory 
should contain specific information on connecting that accessory. 
 
See the illustrations in the next sections for the locations of the 
connectors. 
 
 

Using pass-through 
connectors 

Your spectrometer is equipped with pass-through connectors for use 
with special accessories.  These connectors allow you to make 
accessory cable connections through the spectrometer.  This eliminates 
the need to run cables through the seal on the sample compartment 
cover or out the top of the sample compartment. 
 

   Warning Improper or unsafe cabling can cause damage to your accessory and 
may create a safety hazard.  Only qualified persons should cable a 
custom accessory using these connectors.  Nicolet is not responsible 
for damage or injury resulting from improper or unsafe cabling. ▲ 

 
To use the pass-through connectors, connect the accessory inside the 
sample compartment and connect the external power or 
communications peripheral to the corresponding pass-through 
connector on the rear panel of the spectrometer. 
 

 Note The “Using connectors for custom accessories” section later in this 
chapter contains current, voltage, pin connection and other 
limitations on using these connectors. ▲ 
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Connectors inside the 
sample compartment 

The following illustration shows the locations of the connectors inside 
the sample compartment: 
 
 

Auxiliary 1 
Control Bus

Detector Auxiliary 2

Purge 
Out

 

Pass-through connector 
(for communications or other signals)

Connector for 
accessory detector

Accessory connector (for 
control and power) with 
pass-through capability 
(for DC power or other signals)

 
 
 
Auxiliary 1/Control Bus – Seven pins on this connector are used to 
provide power and communications between the spectrometer and an 
accessory.  Accessories such as the Nicolet sample shuttle use this 
capability.  Nine pins on the connector can be used for passing DC 
power input or other signals from the Auxiliary 1 connector on the 
rear panel to an accessory.  For example, the automatic sample wheel 
and the ProfilIR accessory get DC power through this connector 
when the DC power output of an AC-to-DC converter is attached to 
the Auxiliary 1 connector on the rear panel. 
 
Detector – If you have a photoacoustic or other accessory that has a 
detector located in the spectrometer sample compartment, connect 
the cable from the detector to this standard connector.   
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Auxiliary 2 – This connector can be used for passing 
communications or other signals from the Auxiliary 2 connector on 
the rear panel.  For example, you can use this connector to attach the 
communications cable from the automatic sample wheel or the 
ProfilIR accessory. 
 
 

Connectors on the rear panel The illustration below shows the connectors on the rear panel of the 
spectrometer: 
 
 

Auxiliary 1 Auxiliary 2

Auxiliary 1 Auxiliary 2
Pass-through 
connector (for 

DC power input 
or other signal)

Pass-through 
connector (for 
communications or 
other signal)  

 
 
Auxiliary 1 – This connector passes power or other signals for the 
accessory to nine pins on the Auxiliary 1 connector inside the sample 
compartment.  This connector could be used, for example, to attach 
the DC output of an AC-to-DC converter. 
 
Auxiliary 2 – This connector passes signals to the  
Auxiliary 2 connector inside the sample compartment.  This 
connector could be used, for example, to allow an accessory in the 
sample compartment to be controlled through your computer’s serial 
(RS-232C) port. 
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Using connectors 
for custom accessories 

You can use the pass-through connectors to provide power and 
communication or other signals for your own custom accessories. 

 
   Warning Improper or unsafe cabling can cause damage to your accessory and 

may create a safety hazard.  Only qualified persons should cable a 
custom accessory using these connectors.  Do not pass signals that 
exceed ±15 VDC through these connectors.  You must also limit the 
current to a maximum of 800 mA.  Nicolet is not responsible for 
damage or injury resulting from improper or unsafe cabling. ▲ 

 
By connecting custom cables that use these pins, you can pass power 
and one or more signals through the spectrometer from the rear panel 
to the sample compartment and vice versa, so long as the voltage 
does not exceed ±15 VDC and you limit the current to a maximum 
of 800 mA. 

 
 ▲ Caution When designing a cable to be used on the Auxiliary 1 connector in 

the sample compartment, never connect signals to pins 1 through 4 
and pins 9 through 11.  These pins carry DC power, ground and 
communications signals from the spectrometer.  They are not 
available for use with custom accessories.  Connecting these pins 
could damage your accessory or the spectrometer. ▲ 
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The following diagram shows schematically, with solid lines, which 
pins of the connectors inside the sample compartment are internally 
connected to pins of the connectors on the rear panel.  Since none of 
these connected pins are assigned by the Magna-IR system, they are 
available for use with custom accessories. 
 
 

15 14 13 12 11 10 9

8 7 6 5 4 3 2 1

6 7 8 9

1 2 3 4 5

6 7 8 9

1 2 3 4 5

9 8 7 6

5 4 3 2 1

Auxiliary 1 / Control Bus (female) Auxiliary 1 (male)

Auxiliary 2 (female)Auxiliary 2 (male)

Sample Compartment 
Connectors

Rear Panel 
Connectors
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  Quick Answers to Your Questions 
About Using OMNIC E.S.P. 

 
 
 

This chapter presents common questions and answers about using 
the OMNIC software.  Each question is followed by a brief answer, 
plus a reference for where you can go for more information. 

 
 

Collecting spectra How do I set the software for collecting spectra? 
 
You can set the software in one step by selecting a stored experiment 
from the Experiment drop-down list box below the OMNIC window 
menu bar.  To set the experiment parameters individually, use 
Experiment Setup in the Collect menu. 
 

 View the “Preparing the Software” unit of the “Collecting a Spectrum” 
tutorial for information on setting the software for collecting spectra. 
 
In the OMNIC Help system Index, find “selecting, experiment” and go 
to the “Selecting an experiment” topic, or find “experiment, 
parameters” and go to the “Setting the experiment parameters” topic. 
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How do I collect a spectrum? 

Set the parameters as explained above and then choose Collect 
Sample from the collect menu.  Depending on the parameter settings, 
you may need to install or remove the sample before choosing 
Collect Sample.   
 

 View the “Collecting the Spectrum of a Sample” unit of the 
“Collecting a Spectrum” tutorial for information on collecting spectra. 
 
In the OMNIC Help system Index, find “collecting, spectrum” and go 
to the “Collecting a sample spectrum” topic or “Collecting a 
background spectrum” topic. 
 
 

How do I specify the Y-axis unit for collecting spectra? 

Choose Experiment Setup from Collect menu and then set Final 
Format on the Collect tab.   
 
You can change the format of a collected spectrum by using 
Absorbance, % Transmittance or Other Conversions in the Process 
menu.  See the question and answer in the next section for a 
description of the available units.   
 

 View the “Typical IR Transmission Spectrum” unit of the “Collecting 
a Spectrum” tutorial. 
 
In the OMNIC Help system Index, find “Y-axis, unit” and go to the 
“Selecting a final format” topic. 
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What does gain do? 

Gain amplifies the detector signal intensity, making it larger relative 
to the level of electronic noise.  This is helpful when the signal is 
weak, such as when you use some sampling accessories.  You can let 
OMNIC automatically adjust the gain to maximize the signal by 
setting the Gain parameter to Autogain.  We recommend using this 
setting to ensure the best spectral quality.   
 

 View the “Setting the Instrument Gain” unit of the “Collecting a 
Spectrum” tutorial. 
 
In the OMNIC Help system Index, find “gain” and go to the “Setting 
the gain” topic. 
 
 
When should I save interferograms with my spectra? 

Save interferograms if you think you may want to restore the original 
data after it has been processed or if you want to keep an archive of 
your raw data.   
 

 View the “Setting parameters for automatic saving” lesson of the 
“Preparing the Software” unit of the “Collecting a Spectrum” tutorial. 
 
In the OMNIC Help system Index, find “saving, interferograms” and 
go to the “File handling” topic. 
 
 
What does the Collect Sample window show? 

The window displays the “live” spectrum as it is being collected plus 
a gauge indicating the progress of the collection, an indicator 
showing whether any problems have occurred and other information 
about the collection. 
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 View the “Collecting the Spectrum of a Sample” unit of the 
“Collecting a Spectrum” tutorial. 

 
 
How do I know my spectra are meeting quality standards? 

OMNIC continuously monitors the quality of the data you collect, 
based on the parameters you set.  The Quality tab in the Experiment 
Setup dialog box contains parameters for specifying the spectral 
quality characteristics that you want checked when you collect 
spectra.  OMNIC offers four categories of spectral quality checks: 
 
• Spectrum checks 
• Parameter checks 
• Background checks 
• Interferogram checks 
 
When OMNIC performs a check and detects a problem, the Collect 
Status indicator is displayed as a yellow circle or a red X.  Click the 
indicator (or click the View Collect Status button at the end of data 
collection) to see a summary of data collection problems encountered 
during the collection and other information about the collection. 
 

 In the OMNIC Help system Index, find “quality” and go to the 
“Quality tab” topic. 
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Converting 
spectra to other units 

Which Y-axis unit should I use for a spectrum? 
 
The most commonly used units are % transmittance and absorbance.  
Use % transmittance if you plan to compare the spectrum visually with 
published reference spectra.  Use absorbance units for quantitative 
analysis measurements.  
 
Kubelka-Munk units are useful for searching diffuse reflectance 
spectra against libraries of absorbance spectra.   
 
Use photoacoustic units for spectra collected using a photoacoustic 
accessory.   
 
Percent reflectance units are mathematically equivalent to % 
transmittance units, but using them for spectra collected using a 
reflection technique serves to identify the sampling technique.   
 
Using log (1/R) units for spectra collected using a reflection 
technique is useful for quantitative comparisons, since there is often 
a linear relationship between the concentration of a component and 
its log (1/R) value. 
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 View the “Typical IR Transmission Spectrum” unit of the “Collecting 
a Spectrum” tutorial. 
 
In the OMNIC Help system Index... 
 

Find “absorbance” and go to the “Converting spectra to 
absorbance” topic. 
 
Find “transmittance (%)” and go to the “Converting spectra to % 
transmittance” topic. 
 
Find “Kubelka-Munk units” and go to the “Kubelka-Munk units” 
topic. 
 
Find “photoacoustic units” and go to the “Photoacoustic units” 
topic. 
 
Find “reflectance (%)” and go to the “% Reflectance units” topic. 
 
Find “log (1/R) units” and go to the “Log (1/R) units” topic. 
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Using 
spectral libraries 

How do I search a spectral library? 
 
First prepare the spectrum (as explained below) and display or select 
the region you want searched.  Then set up the search using Library 
Setup in the Analyze menu and start the search by choosing Search 
from the Analyze menu. 
 

 In the OMNIC Help system Index, find “searching, spectral library” 
and go to the “Setting up a library search” topic or “Searching a 
spectral library” topic. 
 
 
How should I prepare my spectrum before searching it against a 
spectral library? 

There are several corrections you can perform on a spectrum to 
obtain the best search results: 
 
• If the baseline of the spectrum is sloped, curved or shifted 

vertically, correct it using Baseline Correct in the Process menu. 
 

 In the OMNIC Help system Index, find “correcting, baseline” and 
go to the “Correcting a baseline manually” topic. 

 
• If the spectrum has totally absorbing bands, eliminate them by 

using Blank in the Process menu.  Be careful not to blank regions 
that contain other important spectral information.   

 

 In the OMNIC Help system Index, find “blanking spectral region” 
and go to the “Blanking a spectral region” topic. 

 
 You can also use the region tool to select a region of the 

spectrum that does not include any totally absorbing bands or use 
the view finder to display the region before searching.  (These 
methods avoid the loss of spectral information that results from 
blanking.) 
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 In the OMNIC Help system Index, find “selecting, spectral region” 
and go to the “Region tool” topic, or find “displaying, spectral 
region” and go to the “View finder” topic. 

 
• If you collected the spectrum using specular or diffuse reflection, 

use Kramers-Kronig (dispersion) correction (available through 
Other Corrections in the Process menu) to correct it for 
dispersion effects and then search it against a library of 
absorbance spectra. 

 

 In the OMNIC Help system Index, find “Kramers-Kronig 
transformation” and go to the “Kramers-Kronig (dispersion) 
transformation” topic. 

 
• If you collected the spectrum using ATR (attenuated total 

reflection), use ATR correction (available through Other 
Corrections in the Process menu) to correct it for variation in the 
depth of penetration and then search it against a library of 
transmission spectra. 

 

 View the “Using an ATR Accessory” tutorial for information on 
using your ATR.  In the OMNIC Help system Index, find “ATR 
correction” and go to the “ATR correction” topic. 

 
• If the spectrum has water or carbon dioxide peaks, use Other 

Corrections to remove these peaks. 
 

 In the OMNIC Help system Index, find “water” and go to the 
“H2O and CO2 correction” topic. 
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Only those portions of the spectrum which are within the selected 
region (or displayed region if no region is selected) and within any of 
the regions you specified for the library using the Region Setup tab 
of the Library Setup dialog box will be included in the search.  If the 
spectral range of the spectrum is broader than that of the library 
spectra, use the region tool to select the region of the spectrum that 
coincides with the library spectra before you start the search.  You 
can also use the view finder to display the region to search.  The 
Search command operates on the selected region, or on the displayed 
region if a region is not selected. 
 

 In the OMNIC Help system Index, find “selecting, spectral region” and 
go to the “Region tool” topic, or find “displaying, spectral region” and 
go to the “View finder” topic. 
 
 
How do I create a spectral library? 

Use the Create Library button on the Library Names tab of Library 
Manager to create a user library.  You can also double-click a 
spectrum on the Library Spectra tab. 
 
Once a library is created, you can add spectra to it with the Add To 
Library button, with Add To Library in the Analyze menu, or by 
dragging the spectrum to the library’s book on the Library Names 
tab of Library Manager.  You can use a search library you create just 
as you would a commercial library to identify unknown spectra or 
verify the composition of a sample.  If you create a scrapbook 
library, you can find spectra in it by searching for text (but not by 
spectral searching).   
 
When you create a library, you determine the kinds of information 
that will be saved with it. 
 

 In the OMNIC Help system Index, find “user library, creating” and go 
to the “Creating a user library” topic. 
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How can I display a library spectrum in a spectral window? 

Locate and select the spectrum in Library Manager and then click the 
Add To Window button, or go to the Library Spectra tab of the 
Library Manager and choose a spectrum. 
 

 In the OMNIC Help system Index, find “displaying, library spectrum” 
and go to the “Working with libraries” topic. 
 
 
How can I find a compound in a commercial library? 

Library Manager in the Analyze menu lets you search for the 
compound name.  After you select the library on the Library Names 
tab, use the features on the Search For Text tab to locate the 
spectrum.  Type the text to search for in the Text In Selected Item 
box, and then choose Search.  The search results appear in the table 
based on the options you have set.  To see information about a found 
spectrum, double-click its row in the table. 
 

 In the OMNIC Help system Index, find “searching, spectral library” 
and go to the “Searching a library for text” topic. 
 
You can use the extended search feature (available on the Extended 
Search tab of the Library Setup dialog box) to find library spectra by 
searching for text in any field included in the library.  For example, 
some libraries have fields for molecular weight, boiling point or 
manufacturer. 
 

 In the OMNIC Help system Index, find “extended search” and go to 
the “Using extended search” topic. 
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What is the easiest way to collect sample spectra and add them to 
a spectral library? 

Use the Collect Spectrum button on the Library Names tab of 
Library Manager to collect a spectrum and add it to a user library.  
The software automatically sets the experiment parameters (for 
example, Resolution) so that the spectrum will be compatible with 
the selected library.  This allows you to collect and add a compatible 
spectrum in one step instead of three (using Experiment Setup to set 
the parameters, Collect Sample to collect the spectrum and Add To 
Library to add the spectrum to the library). 
 

 In the OMNIC Help system Index, find “collecting, spectrum” and go 
to the “Working with libraries” topic. 
 
 
What does the search expert do? 

It determines the spectral regions to search, searches those regions 
and then displays the specified number of library spectra that best 
match the unknown spectrum, plus comments about the search 
results.  For example, the search expert may tell you that the best 
match is excellent but the second best match is also similar to the 
unknown.  You will be able to display the list of matches to see their 
match values and index numbers. 
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Opening, saving 
and deleting spectra 

 

 

How do I open a stored spectrum? 
 
Choose Open from the File menu (or click the Open button in the 
toolbar if displayed), locate the spectrum or spectra you want to open, 
select the filenames of the spectra and then choose OK.  You can also 
hold down the Control key and select multiple files to open. 
 

 In the OMNIC Help system Index, find “opening, spectrum” and go to 
the “Opening spectra” topic. 
 
 
How can I automatically save my collected spectra? 

Choose Experiment Setup from the Collect menu and turn on Save 
Automatically on the Collect tab (Save Automatically is on by 
default).  Specify a base name for naming the saved spectral data 
files in the Base Name box.  A sequential number will be appended 
to the base name when the spectra are saved.  If you want the 
interferograms saved with the spectra, turn on Save Interferograms. 
Individual spectra are saved with the extension .SPA. 
 

 View the “Setting parameters for automatic saving” lesson in the 
“Preparing the Software” unit of the “Collecting a Spectrum” tutorial. 
 
In the OMNIC Help system Index, find “saving, spectra” and go to the 
“File handling” topic. 
 
 
Where should I save my spectra? 

You have several options for saving spectra; you may choose to use 
more than one.  For a permanent record of the spectrum and any 
other information you want to record, use a report notebook. 
 

 In the OMNIC Help system Index, find “report notebook” and go to 
the “Adding a report to a notebook” topic. 
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You can also place spectra in descriptively named user libraries that 
you create.  Keeping spectra in libraries allows you to find them by 
searching for text contained in the information saved with the 
spectra. 
 

 In the OMNIC Help system Index, find “spectrum” and go to the 
“Adding a spectrum to a user library” topic. 
 
We recommend that you create descriptively named folders 
(directories) on your hard disk for different categories of spectra.  
For example, you could have a folder for each project you are 
working on, for each of your clients, for each laboratory application, 
or for each sample type.  See your Windows documentation for 
information on creating directories.  You can specify which folder to 
use when you use Save or Save As in the File menu to save spectra.  
This will make it easier to find a spectrum in a particular category 
when you use Open in the File menu to open a spectrum. 
 

 In the OMNIC Help system Index, find “spectrum, saving” and go to 
the “Saving spectra with a new filename” topic. 
 
 
How can I save several spectra in one file as a group? 

Select the spectra and then choose Save Group from the File menu.  
To select more than one spectra, hold down the Control key and 
click each spectrum you want to select with the selection tool, and 
then release the Control key.  Spectral groups are saved with the 
extension .SPG. 
 

 In the OMNIC Help system Index, find “saving, spectra” and go to the 
“Saving a group of spectra” topic. 
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How can I delete stored spectra? 

Choose Delete Files from the File menu to display the Delete Files 
dialog box.  Locate and select the spectral data files (with the 
extension .SPA, or .SPG for spectral group files) you want to delete 
and then choose OK. 
 

 In the OMNIC Help system Index, find “deleting, spectra” and go to 
the “Deleting files” topic. 
 
 
Can I delete an entry from a report notebook? 

No.  OMNIC’s report notebooks are similar to traditional laboratory 
notebooks in that information you add to them becomes part of the 
permanent record of your work.  You can delete an entire notebook, 
however, by deleting the entire notebook file.  Choose Delete Files 
from the File menu to display the Delete Files dialog box.  Locate 
and select the subdirectory containing the notebook data files (with 
the extension .NBK).  You will have to set the List Files Of Type 
box to All (*.*) to see .NBK files listed.  Select the file you want to 
delete and then choose OK. 
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Printing  How can I specify a printer for printing information? 
 
Use Printer Setup in the File menu.  See your Windows documentation 
for details on setting the printer parameters. 
 

 In the OMNIC Help system Index, find “printer” and go to the “Setting 
up the printer” topic.   
 
 
How can I create and print reports of my work? 

Use the commands in the Report menu.  First use Template to select, 
edit or create a template for the report.  Then use Preview/Print 
Report to view the report as it will appear on paper.  Click the Print 
button to print the report.   
 

 In the OMNIC Help system Index, find “template” and go to the 
“Selecting, editing or creating a report template” topic, or find “report, 
previewing or printing” and go to the “Previewing or printing a report”
topic.   
 
You can also use Add To Notebook to add the report to a report 
notebook.  You can then print the report with the Print button when 
you view the notebook using View Notebook. 
 

 In the OMNIC Help system Index, find “adding, report to notebook” 
and go to the “Adding a report to a notebook” topic.   
 
 
How can I preview spectra or other information before printing? 

Use Preview/Print Report in the Report menu to view a report as it 
would appear on paper.  The report is displayed using the current 
report template; that is, the template you have specified with 
Template or the template you are viewing and working with.  If the 
report is displayed as you want it to appear on paper, you can print it 
by using the Print button. 
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 In the OMNIC Help system Index, find “template” and go to the 
“Selecting, editing or creating a report template” topic, or find “report, 
previewing or printing” and go to the “Previewing or printing a report”
topic.   

 
 

Displaying spectra How can I select more than one spectrum at a time? 
 
Hold down the Control key while you click the spectrum.  You can 
also choose Select All from the Edit menu to select all the spectra in 
the window that are not hidden. 
 

 In the OMNIC Help system Index, find “selecting, spectra” and go to 
the “Selection tool” topic or “Selecting all the spectra in a spectral 
window” topic.  
 
 
How can I specify colors for displaying spectra? 

Choose Options from the Edit menu, click the View tab and then 
choose Colors.  In the Colors dialog box click the color next to the 
spectrum number for which you want to specify the color and then 
click the desired color in the color array.  To specify the color for 
selected spectra, click the color next to Selected Spectrum and then 
click a color.  Typically red is the color reserved for displaying 
selected spectra. 
 

 In the OMNIC Help system Index, find “spectra, colors” and go to the 
“Specifying colors for spectra and other features” topic.  
 
You can also specify colors for displaying spectra in a particular 
spectral window.  Start by selecting the spectra for which you want 
to specify a color, and then choose Display Setup from the View 
menu.  Click the desired color in the color array and then choose OK.  
When the spectra are no longer selected, such as after you select a 
different spectrum, they will be displayed in the color you clicked. 
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 In the OMNIC Help system Index, find “spectra, colors” and go to the 
“Selecting a color for the currently selected spectra” topic.  
 
 
What is the difference between the Display Setup parameters 
and the Window options? 

The parameters in the Display Setup dialog box affect the currently 
active spectral window only.  The options in the Window options (in 
the Options dialog box) affect all the new spectral windows that you 
create.  After you create a new spectral window, you can change the 
way spectra are displayed in it by using Display Setup. 
 

 In the OMNIC Help system Index, find “display parameters” and go to 
the “Setting the display parameters” topic, or find “Window options” 
and go to the “Window options” topic.  
 
 
What can I do with the “Scale” commands in the View menu? 

By using the appropriate command, you can display spectra so that 
they are easier to see or compare.   
 
Full Scale displays the spectra so that they perfectly fit their panes 
vertically.  Automatic Full Scale does this automatically when you 
change the display with the view finder or selection tool.  The Y-axis 
displayed corresponds to the selected spectrum. 
 
Common Scale displays all the spectra so that they are not cut off at 
the top or bottom and use the same Y scale.  This allows you to 
compare the band intensities of different spectra. 
 
Match Scale changes the Y scale of the spectra to be the same as that 
of the selected spectrum.  (The selected spectrum’s scale is not 
changed.)  This allows you to compare the band intensities of 
different spectra.   
 
Offset Scale shifts the spectra vertically so that they overlap less, 
making them easier to see. 
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When you use these commands, keep in mind that the current Y-axis 
is always accurate for the currently selected spectrum but may not 
apply to other spectra in the window. 
 

 In the OMNIC Help system Index... 
 

For information on Full Scale or Automatic Full Scale, find 
“displaying, spectra” and go to the “Displaying spectra full scale” 
topic or “Displaying spectra full scale automatically” topic. 
 
For information on Common Scale, find “displaying, spectra” and 
go to the “Displaying spectra using the same Y-axis” topic. 
 
For information on Match Scale, find “displaying, spectra” and go 
to the “Matching the Y scale of a spectrum” topic. 
 
For information on Offset Scale, find “displaying, spectra” and go 
to the “Displaying spectra vertically offset” topic. 

 
 
How can I zoom in on an area of a spectrum? 

 
Draw a box around the area using the selection tool and then click 
inside the box.  
 

 
You can also click the top half of the Expand/Contract button at the 
left end of the view finder or drag the regions markers in the view 
finder to display a smaller spectral region. 
 
In addition you can use the Roll/Zoom window available in the View 
menu (or click the Roll/Zoom window button in the toolbar if 
displayed) to expand an area. 
 

 In the OMNIC Help system Index, find “expanding, spectrum” and go 
to the “Selection tool” topic, “View finder” topic or “Rolling and 
zooming spectra” topic.  
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How can I move a spectrum up or down in its pane to see it 
better? 

 
Use the selection tool to drag the spectrum up or down. 
 
You can also use the Roll/Zoom window available in the View menu 
to move a spectrum up or down. 
 

 In the OMNIC Help system Index, find “moving, spectrum” and go to 
the “Selection tool” topic or “Rolling and zooming spectra” topic.  
 
 
How can I move a spectrum into another spectral window? 

 
Use the selection tool to drag the spectrum from one spectral window 
to another.  A copy of the spectrum appears in the second window, and 
the original spectrum remains in the first window.  You can also copy 
or cut the spectrum using Copy or Cut in the Edit menu and then paste 
it into another spectral window using Paste. 
 

 In the OMNIC Help system Index, find “moving, spectrum” and go to 
the “Selection tool” topic, or find “pasting, spectrum” and go to the 
“Pasting items” topic. 
 
 
How can I move a stacked spectrum into another pane? 

 
Use the selection tool to drag the spectrum from one pane into another. 

 

 In the OMNIC Help system Index, find “moving, spectrum” and go to 
the “Selection tool” topic.  
 
 
How can I find the X and Y values of a point in a spectrum? 

 
Use the spectral cursor tool to click the point.  The values are displayed 
in the readout above the palette.  
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 In the OMNIC Help system Index, find “Displaying, X and Y values” 
and go to the “Spectral cursor tool” topic.  
 
 
How can I find the height of a peak? 

 
Use the peak height tool to click the top of the peak.  Then drag the 
baseline handles to adjust the baseline used for the measurement.  The 
corrected (measured above the baseline) and uncorrected height values 
appear in the readout above the palette.  
 

 In the OMNIC Help system Index, find “Peak, height” and go to the 
“Peak height tool” topic.  
 
 
How can I find the area of a peak? 

 
Use the peak area tool to drag across the peak.  Then drag the baseline 
handles to adjust the baseline used for the measurement.  The corrected 
(measured above the baseline) and uncorrected area values appear in 
the readout above the palette.  
 

 In the OMNIC Help system Index, find “Peak, area” and go to the 
“Peak area tool” topic.  
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Correcting spectra Should I correct the baseline of my spectrum? 
 
If a baseline is sloped or curved or significantly above zero absorbance 
(or below 100% transmittance), a likely cause is how the sample was 
prepared.  By correcting the baseline, you can often avoid having to 
prepare the sample again and collect a new spectrum. 
 
Correcting a baseline will give you better results when you search 
the spectrum against a library, subtract the spectrum from another 
spectrum, find peaks in the spectrum or quantify components in the 
spectrum. 
 

 View the “Common Problems” unit of the “Collecting a Spectrum” 
tutorial. 
 
In the OMNIC Help system Index, find “correcting, baseline” and go 
to the “Correcting a baseline manually” topic. 
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Subtracting, 
adding, multiplying 

and dividing spectra 

How can I subtract a spectrum from another spectrum?  
 
Use Subtract in the Process menu whenever you want to subtract one 
spectrum from another.  Subtract is commonly used to remove spectral 
features of solvent residues or pure components from the spectrum of a 
mixture of compounds. 
 
Select the spectrum from which you want to subtract spectral 
features; this is the sample spectrum.  Then hold down the Control 
key and select the spectrum with the features you want to subtract 
from the sample spectrum; this is the reference spectrum. 
 

 Note Subtract is available in the Process menu only when two spectra are 
selected. ▲ 
 
Choose Subtract from the Process menu.  The difference spectrum is 
displayed full scale in the bottom pane.  This spectrum is the result 
of subtracting the reference spectrum from the sample spectrum 
using the subtraction factor shown to the left of the result.  If you are 
not satisfied with the subtraction result, you can change the 
subtraction factor. 
 

 In the OMNIC Help system Index, find “subtracting, spectra” and go to 
the “Subtracting spectra” topic. 
 
 
What should I use subtraction for? 

Subtract is commonly used to remove spectral features of solvent 
residues or pure components from the spectrum of a mixture of 
compounds.  When you use Subtract, the software calculates data 
point by data point the difference between the two. 
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Spectral subtraction is useful in a variety of situations.  Here are 
some examples:   
 
• Eliminating solvent peaks in a spectrum of a sample that is 

dissolved in a solvent. 
 
• Separating components from a sample that is a mixture of two or 

more components. 
 
• Identifying an unknown contaminant by subtracting out the 

known sample material. 
 
• Ensuring quality by subtracting an original batch sample 

spectrum from a spectrum from the next batch. 
 
 
What other arithmetic operations can I perform on my spectra? 

You can manipulate your spectra using any of the common 
arithmetic operations.  Use Spectral Math in the Process menu to 
perform these operations on one or two selected spectra.  You 
specify the operations to perform by typing a sequence of 
mathematical symbols and numbers.  The software performs the 
operations on the Y values of the data points in the spectrum or 
spectra and then displays the result spectrum. 
 
When you choose the command, the Spectral Math window appears 
allowing you to type the desired operations in the Operation text box.  
You can also select one of the example operations provided in the 
Operation drop-down list box. 
 

 In the OMNIC Help system Index, find “spectrum” and click the topic 
that corresponds to the operation you want to perform. 
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Customizing OMNIC How can I customize my OMNIC software? 
 
You can use Options in the Edit menu to set options that determine 
how the software operates.  You can also customize the menus and the 
toolbar using Edit Menu and Edit Toolbar in the Edit menu.  Use Save 
Configuration As in the File menu to save your customized settings in 
a configuration file.  You can then open the file later to reset OMNIC 
to your preferences in one step. 
 

 View the “Preparing the Software” unit of the “Collecting a Spectrum” 
tutorial. 
 
In the OMNIC Help system Index... 
 

Find “options” and go to the “Customizing OMNIC by setting 
options” topic. 
 
Find “customizing, menu” and go to the “Customizing a menu” 
topic. 
 
Find “customizing, toolbar” and go to the “Customizing a toolbar” 
topic. 
 
Find “saving, configuration” and go to the “Saving a 
configuration” topic. 
 
Find “opening, configuration” and go to the “Opening a 
configuration” topic. 
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Other questions How can I find and label peaks in spectra? 
 
Use Find Peaks in the Analyze menu to find and label peaks above a 
specified threshold.   
 

 
You can also use the annotation tool to label individual peaks.  

 

 In the OMNIC Help system Index, find “finding peaks” and go to the 
“Finding peaks above a specified height” topic, or find “labeling 
peaks” and go to the “Annotation tool” topic. 
 
 
How can I close a task window (such as the Find Peaks window)? 

 
 
 

 

In Windows 95 or Windows NT 4.0, click the Close button (if 
available) in the upper-right corner of the window or double-click the 
button at the left end of the window’s title bar (if the window is not 
maximized) or the button at the left end of the menu bar (if the window 
is maximized).  In Windows 3.1 (or 3.11) or Windows NT 3.5, double-
click the Control-menu box in the upper-left corner of the task window 
(not the OMNIC window’s Control-menu box). 
 

 In the OMNIC Help system Index, find “closing, task window” and go 
to the “Task windows” topic. 
 
 
How can I select a spectral region for an operation? 

 
Use the region tool to drag across the region in the pane.  

 

 In the OMNIC Help system Index, find “selecting, spectral region” and 
go to the “Region tool” topic. 
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How can I display information about how a spectrum was 
collected and processed? 

Select the spectrum and then click the Information button to the left 
of the title box.  You can also double-click the spectrum’s title in the 
title box. 
 

 In the OMNIC Help system Index, find “collection and processing 
information” and go to the “Collection and processing information” 
topic. 
 
If you want this kind of information displayed in a spectrum’s pane, 
choose Display Setup from the View menu, turn on Sampling 
Information and then specify the types of information you want 
displayed by turning on options in the Sampling Information box. 
 

 In the OMNIC Help system Index, find “displaying, sampling 
information” and go to the “Displaying sampling information” topic. 
 
 
How can I copy a spectrum and paste it into a text document? 

Select the spectrum and choose Copy from the Edit menu.  This 
places the spectrum on the Clipboard in the form of a Windows 
metafile (this is the file format with the most flexibility for pasting 
into other programs).  You can then paste the spectrum into a 
document by using a word processing program. 
 

 In the OMNIC Help system Index, find “copying, spectrum” and go to 
the “Copying items” topic. 
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How can I get on-line Help while using the software? 

The OMNIC on-line Help system lets you quickly find answers to 
your questions about using the software.  There are several ways to 
enter the Help system: 
 
• To see information about a particular feature in OMNIC, click the 

feature using the right mouse button.  A brief description of the 
feature appears, and in most cases one or more buttons that you can 
click to display more detailed information.  Click the Discussion 
button to display a complete discussion of the feature (or the dialog 
box or window that contains the feature).  Click the How To button 
to display a step-by-step procedure for using the feature (or the 
dialog box or window that contains the feature). 

 
• You can press the F1 function key at any time to see a discussion 

topic for the currently displayed or selected feature, dialog box or 
window. 

 
• If a dialog box or window contains a Help button, click it to see 

information about the dialog box or window (or the command 
that displayed it). 

 

• To see the Contents of the OMNIC Help system, choose OMNIC 
Help Topics from the Help menu. 

 
 
What telephone number should I call to get answers to other 
questions? 

Contact Nicolet at one of the numbers below.  Outside the U.S.A. call 
your local sales or service representative.  Telephone numbers for all 
Nicolet Customer Support offices are provided with your system. 
 

• Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538) 
• Fax: 1-608-273-6045 
• World Wide Web: http://www.nicolet.com 
• E-mail: nicinfo@nicolet.com ▲ 
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  Quick Answers to Your Questions 
About Using the Spectrometer 

 
 
 

This chapter presents common questions and answers about using 
your spectrometer.  Each question is followed by a brief answer, plus 
a reference for where you can go for more information. 

 
 

Do I need to use an energy screen with my detector?  

If you are using a highly sensitive detector such as a Si, PbSe,  
MCT-A or InSb detector and your experiment deals with information 
from a broad range of frequencies, use an energy screen to prevent 
the detector from becoming saturated or producing a distorted signal. 
 

 See “Setting up for experiments” available through Installing 
Hardware in the Help menu for instructions on installing energy 
screens. 
 
 
Do I need to use a bandwidth-limiting filter? 

If you are using a highly sensitive detector such as a Si, PbSe,  
MCT-A or InSb detector and your experiment deals with information 
in a narrow range of frequencies, a bandwidth-limiting filter can 
prevent the detector from becoming saturated or producing a 
distorted signal.  Bandwidth-limiting filters improve the signal-to-
noise ratio of the data and also prevent detector saturation by 
allowing only energy in your particular area of interest to pass to the 
detector element.   
 

 See “Setting up for experiments” available through Installing 
Hardware in the Help menu for instructions on installing filters. 
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Why do I need to use an aperture?  

An aperture of the appropriate size is needed to preserve the line 
shape of spectra when you collect data at higher resolutions.  
OMNIC automatically calculates the default aperture size based on 
the resolution, mirror velocity and spectral range.  If you change the 
settings of these items, the software changes the aperture setting 
accordingly and informs you when you close the Experiment Setup 
dialog box.  You can then specify whether to use the changed setting 
or the previous setting. 
 

 In the OMNIC Help system Index, find “aperture” and go to the 
“Setting the aperture size” topic for information on setting the Aperture 
parameter. 
 
 
When do I need to open the spectrometer cover?  

If you have a System 560, you need to open the spectrometer cover 
to change beamsplitters or detectors.  Also, you need to open the 
cover of a System 560 or 760 if you are installing a spectrometer 
component such as a source, laser or power supply. 
 

 See “Opening the cover” available through Replacing Parts in the Help 
menu for instructions on opening the cover. 
 

   Warning Do not operate the spectrometer with the main cover open.  The 
cover protects you from exposure to laser light and live electrical 
connections.  If you must open the main cover for maintenance or 
service reasons, always turn the spectrometer power off first. ▲ 
 
 
When should I align the spectrometer?  

Align the spectrometer after you install a new beamsplitter, replace 
the laser or move the spectrometer.  It is also a good idea to align the 
spectrometer if the signal intensity has dropped significantly from its 
usual level. 
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 View the “Testing Performance” unit of the “Collecting a Spectrum” 
tutorial for information on when to align the spectrometer. 
 
In the OMNIC Help system Index, find “aligning, optical bench” and 
go to the “Aligning the optical bench” topic for information on 
performing an automatic alignment. 
 
 
Does my detector need to be cooled with liquid nitrogen?  

Detectors that have a dewar need to be cooled.  Dewar detectors are 
fairly large silver cylinders with a hole in the top.  These include 
MCT and InSb detectors.  To determine if your detector requires 
cooling, open the detector access door, or the spectrometer cover if 
there is no access door, and see if the detector has a dewar. 
 
If during a work session you find that the signal intensity from your 
cooled detector is decreasing, it may need to be refilled with liquid 
nitrogen. 
 

 Choose Replacing Parts from the OMNIC Help menu and view the 
“Cooling a detector” tutorial in the “Replacing parts” book for 
information on cooling a detector. 
 
 
When should I change the desiccant? 

If your spectrometer is sealed and desiccated, there is an indicator in 
the optics area that shows when the desiccant needs to be changed.  
You should check the indicator every two months.  To check the 
indicator, remove the sample tray from the main cover of the 
spectrometer.  If the indicator is pink, the desiccant needs to be 
replaced.  The indicator itself does not need to be replaced. 
 
See the replacement parts list included in your manual set to find the 
part number for desiccant packets.  Packets come in sets of five, but 
four packets should be enough for replacement.   
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 Choose Replacing Parts from the OMNIC Help menu and view the 
“Changing desiccant” tutorial in the “Replacing parts” book for 
information on checking and changing the desiccant. 
 
 
Which source should I use?  

Use the source that is appropriate for the spectral range of your 
experiment (determined by the ranges of the beamsplitter and 
detector).  Nicolet offers a mid-IR to far-IR source (Ever-Glo) and a 
near-IR source (white light). 
 

 In the OMNIC Help system Index, find “source” and go to the 
“Specifying the source type” topic for information on setting the 
Source parameter. 
 
See “Selecting the right beamsplitter and detector” in the “Using 
beamsplitters and detectors” section of the “Spectrometer Basics” 
chapter of this manual for a table showing the compatibility of sources, 
beamsplitters and detectors. 
 
 
What do the purge shutters do?  

When closed, the purge shutters seal off the optics areas of the 
spectrometer from the sample compartment.  This allows you to 
open the sample compartment to install a sample or accessory 
without letting water and carbon dioxide enter the rest of the 
spectrometer. 
 

 View the “Purging the optical bench” lesson in the “Preparing Your 
Optical Bench” unit of the “Collecting a Spectrum” tutorial for 
information on connecting using the purge shutters. 
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Should I turn off the spectrometer when I’m not using it?  

We recommend that you leave the spectrometer on.  This improves 
the thermal stability of the system and gives you more consistent 
results when you collect spectra. 
 
 
How can I diagnose problems with the spectrometer? 

The performance of the spectrometer is monitored while you collect 
spectra.  If a problem occurs a troubleshooting message displays on 
your screen. 
 

 See the troubleshooting information available through Troubleshooting 
in the Help menu for instructions on diagnosing spectrometer 
problems, ordering parts and replacing parts. 
 

 Note If you wish to view the on-line videos to help you in troubleshooting 
a problem, put the Spectrometers Tutorials CD in the computer. ▲ 
 
You can also make a more thorough check on a spectrometer 
component by choosing Advanced Diagnostics from the Collect 
menu.  This starts the Bench Diagnostics program, which provides 
information on the status of the component as well as 
troubleshooting information, replacement procedures and 
information on ordering replacement parts.  See the “Service and 
Maintenance” chapter of this manual for more information. 
 

 In the OMNIC Help system Index, find “diagnostics” and go to the 
“Checking bench components” topic. 
 
 
How do I replace parts in the spectrometer? 

 Choose Replacing Parts from the OMNIC Help menu and choose the 
appropriate part. 
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What telephone number should I call to get answers to other 
questions?  

Contact Nicolet at one of the numbers below.  Outside the U.S.A. 
call your local sales or service representative.  Telephone numbers 
for all Nicolet Customer Support offices are provided with your 
system. 
 
• Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538) 
• Fax: 1-608-273-6045 
• World Wide Web: http://www.nicolet.com 
• E-mail: nicinfo@nicolet.com ▲ 
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  Service and Maintenance 
 
 
 

This chapter describes service and maintenance routines that you can 
perform on the spectrometer.  We define service as a procedure to 
replace a failing part in the spectrometer.  We define maintenance as 
an occasional procedure you perform to keep the spectrometer 
running efficiently. 
 

   Warning Perform only those routines described in this chapter.  If there are 
other problems, contact Nicolet at one of the numbers below.  
Outside the U.S.A. call your local sales or service representative.  
Telephone numbers for all Nicolet Customer Support offices are 
provided with your system. 
 
• Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538) 
• Fax: 1-608-273-6045 
• World Wide Web: http://www.nicolet.com 
• E-mail: nicinfo@nicolet.com ▲ 
 

 See the troubleshooting information available through Troubleshooting 
in the Help menu for instructions on diagnosing spectrometer 
problems, ordering parts and replacing parts. 
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Running 
diagnostic tests 

If your system is not performing properly, you can use the Diagnostic  
tab in the Experiment Setup dialog box to check the performance of 
spectrometer components.  You should run these diagnostic tests if you 
have problems with your spectrometer to determine the source of the 
problem. 
 
To run the spectrometer diagnostic tests: 
 
1. Make sure the main sample compartment is empty. 

Remove any samples and sampling accessories. 
 
 
2. Choose Experiment Setup from the Collect menu. 

 
3. Click the Diagnostic tab. 

The Diagnostic tab appears showing icons for the major 
components of the spectrometer with a live display of the signal 
from the detector. 

 
 
4. To see information about a component, click that 

component’s indicator icon.   

When you click one of the indicators, a dialog box appears 
showing information about the status of the component.  If the 
operating values for the component are within proper limits, a 
check mark appears in the Status column.  If the value is outside 
the acceptable range, an X appears in the Status column. 
 
When you are finished viewing the information, choose OK. 
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Service  Three spectrometer components—the light source, the laser module 
and the main power supply—were designed so you can replace them 
yourself if they fail. 
 

 Note The diagnostics software will alert you to failing components. See 
the troubleshooting information available through Troubleshooting 
in the Help menu for instructions on diagnosing spectrometer 
problems, ordering parts and replacing parts. ▲ 
 
If the source, laser module or power supply must be replaced, refer 
to the replacement parts list available through Replacing Parts in the 
Help menu.  Call 1-800-NICOLET (1-800-642-6538) or 1-608-276-
6373 to order the replacement assembly.  If you are outside the U.S., 
contact your local Nicolet office.  Telephone numbers for all Nicolet 
Customer Support offices are provided with your system.   
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Maintenance  The rest of this chapter describes how to use the OMNIC software to 
align the spectrometer and accessories, and run performance tests.  
 

 Instructions for other common maintenance procedures, such as 
changing desiccant, cleaning the purge filter and cleaning the outside 
of the spectrometer are available on-line.  Choose the “Maintaining 
your optical bench” book available through Replacing Parts in the Help 
menu. 
 
 

Alignment To ensure optimum system performance (high signal intensity, low 
noise and good sensitivity), you should occasionally align the 
spectrometer.  Use the OMNIC software to align your spectrometer. 
 

 Note If you have just turned on or moved the spectrometer, wait 15 
minutes (one hour for best results) before you align it so the 
spectrometer will have time to stabilize. ▲ 
 

Follow these steps: 
 
1. Remove any sample or accessory from the spectrometer. 

The beam path must be clear during alignment.  Open the sample 
compartment as briefly as possible to maintain a constant purge. 

 
 
2. Choose Experiment Setup from the Collect menu. 

The Experiment Setup dialog box appears. 
 
 
3. Make sure Sample Compartment on the Bench tab is set to 

Main. 
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4. Set Gain on the Bench tab to a value that is appropriate for 
the detector type you are using.  Do not use Autogain. 

An interferogram is shown in the live display.  In the OMNIC 
Help system Index, find “experiment” and go to the “Using 
Experiment Setup” topic for more information. 
 
If you want to view a single-beam spectrum instead, turn on the 
Single Beam check box on the Bench tab. 

 
If you want to hear a tone whose pitch indicates the signal 
intensity, turn on the Tone check box on the Bench tab.  The tone 
reaches its highest pitch when the signal is maximized.  

 
 
5. To perform an alignment, click the Align button on the 

Diagnostic tab.  

When you click the Align button, the system begins to optimize 
the IR signal for maximum energy throughput.  Alignment 
should take 2 to 4 minutes.   

 
The live display of the detector signal changes as each 
interferogram is collected.  The highest and lowest signal 
intensities are shown next to Max and Min at the top of the live 
display.  The interferogram location will be shown next to 
Location, unless you turned on Single Beam. 

 
 
6. When the alignment is finished, close the Experiment Setup 

dialog box.  
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Aligning an accessory You can also align accessories that mount inside a sample 
compartment.  First align the spectrometer, as described above.  Then 
set Sample Compartment on the Bench tab of the Experiment Setup 
dialog box according to the accessory location.  Set Gain to a value 
that gives a signal intensity that is appropriate for the accessory.  ATR 
and diffuse reflection accessories typically use a Gain setting of 2 or 4.
 
If you are not satisfied with the signal intensity after alignment, you 
can manually align most accessories to maximize the signal.  For 
complete instructions, see the manual that came with the accessory.  
 
When you manually adjust an accessory, watch the largest 
interferogram peak.  The larger this peak, the better is the signal 
intensity.   
 

 Note The largest interferogram peak can be positive or negative. ▲ 
 
If you are unable to see the display, turn on Tone before adjusting 
the accessory.  The tone reaches its highest pitch when the signal is 
maximized.  
 
 

Performance test The performance test can be used to track long-term spectrometer 
performance.  Run it after you have installed the system and then 
weekly.  Keep a record of the actual values obtained.  When you run 
the test, the software measures the response of the spectrometer optics 
and atmospheric absorptions in the spectrometer and then collects a 
“sample” spectrum with no sample in place.  The result is a “100% 
line,” a display of system noise that appears as a generally flat line at 
100% transmittance. 
 
Follow these steps to conduct a performance test: 
 
1. Make sure the main sample compartment is empty. 

Remove any samples and sampling accessories. 
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2. Exit OMNIC to ensure that the Bench Diagnostics software 
runs correctly. 

 
3. Start the Bench Diagnostics software. 

Click the Start button, then the Programs icon and then the 
OMNIC folder.  Choose Bench Diagnostics. 
 
For more information on running the Bench Diagnostics 
programs, see the “Bench Diagnostics” section in the 
“Troubleshooting Hardware Problems” chapter of this manual. 
 
 

4. Follow the directions that appear on the screen to run the 
performance test.  

Click the Performance Tests button and conduct the test as 
instructed by the software.     

 
 Note If the noise readings are greater than normal or have changed 

significantly, call the Nicolet Customer Support Department for 
assistance.  Outside the U.S., call your local service representative. 
Telephone numbers for all Nicolet Customer Support offices are 
provided with OMNIC Help. ▲ 

 
If special performance tests are available for your spectrometer, a 
button labeled “Extended Tests” (or another appropriate name) 
will appear.  Click this button and follow the instructions that 
appear on the screen to perform the tests. 
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  Troubleshooting Software Problems 
 
 
 

OMNIC software automatically and continuously checks the status 
of your system.  If a problem is found, a message automatically 
appears allowing access to more information.  This chapter lists 
some simple troubleshooting measures you can take to solve 
software problems with the OMNIC software.  If the action does not 
solve the problem, call your Nicolet service office.   
 
This chapter lists some simple troubleshooting measures you can 
take to solve software problems with the OMNIC software.  If the 
action does not solve the problem, call your Nicolet service office.   

 
 Note For more information on troubleshooting, consult the OMNIC on-

line Help system. ▲ 
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Problem Possible Cause Solution 

After data collection a 
message says the 
sample and background 
spectra have the wrong 
resolution. 

The resolution or data spacing 
of the current background 
spectrum does not match the 
resolution selected for the 
sample spectrum collection. 

Change the setting of Resolution to a 
value within the specified range and 
collect the spectrum again. 

The Quantify command 
is dimmed. 

No quantitative analysis 
method is selected. 

Select the quantitative analysis method 
using Quant Setup in the Analyze 
menu. 

   
 No spectrum is selected. Select a single spectrum. 
   
 The quantitative analysis 

Quantify method is not 
appropriate for the selected 
spectrum. 

Select an appropriate method for the 
selected spectrum. 

OMNIC needs to be 
restored after a system 
crash or a message 
states that OMNIC 
cannot start or will no 
longer run. 

There is not enough memory.  
 
 
 

There is another system 
problem. 

Make sure OMNIC has enough 
memory.  Quit other programs to free 
memory for OMNIC.  

 
Restart OMNIC.  
 
Run the SCANDISK utility included 
with your Windows software. 
 
Reinstall the OMNIC software. 
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  Troubleshooting Hardware Problems 
 
 
 

OMNIC continuously monitors the operation and status of your 
spectrometer and informs you if a problem is found.  The Bench 
Status indicator below the menu bar shows the status of the 
spectrometer operation.  When OMNIC performs a check and detects 
a problem, the Bench Status indicator is displayed as a yellow circle 
or a red X along with an message alerting you to the problem. 
 
This chapter lists some simple troubleshooting measures you can 
take to solve problems with the spectrometer.  The Bench 
Diagnostics program is described at the end of the chapter.  If your 
actions do not solve the problem, call your Nicolet service office.   

 
 Note For more information on troubleshooting, use Troubleshooting in the 

OMNIC Help menu. ▲ 

 
   Warning Always follow the safety precautions included in this manual and in 

your Optical Bench Safety Guide when performing any of the 
following troubleshooting procedures. ▲ 
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Problem Possible Cause Solution 

The indicators on the 
front panel do not light 
when the spectrometer 
is turned on. 

The spectrometer is not 
plugged in. 

Make sure the power cord is plugged 
into the spectrometer and a working 
wall outlet. 

 The power cable or power 
supply is defective. 

Call Nicolet to order a replacement 
part. 

   
 A fuse is blown. Replace the fuse.  Choose Replacing 

Parts from the OMNIC Help menu and 
choose the “Replacing a fuse” tutorial 
from the “Replacing parts” book. 

The Scan indicator on 
the front panel does not 
flash (the system is not 
scanning). 

The spectrometer is out of 
alignment. 

Align the spectrometer.  Use the Align 
button on the Diagnostic tab in the 
Experiment Setup dialog box. 

 After 1 hour without data 
collection activity, the 
interferometer stops scanning 
and the Scan light stays on.  
This mode is normal. 
 
The beamsplitter is not 
properly seated. 
 
The spectrometer cover is ajar. 
 
 
An electronic miscue has 
occurred. 
 
A component has failed. 

No action is required.  Any data 
collection activity will cause the 
interferometer to begin scanning.  
 
 
 
Check the beamsplitter. 
 
 
Close the cover and tighten the cover 
thumbscrews. 
 
Turn off the spectrometer power for 
10  seconds. 
 
Call Nicolet for service.  

There is frost on the 
outside of the detector. 

The insulating vacuum 
chamber surrounding the 
dewar has begun to leak. 

If you suspect that your detector has a 
vacuum leak, choose Troubleshooting 
from the OMNIC Help menu. 
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Problem Possible Cause Solution 

Data are not displayed 
during data collection. 

The laser is not functioning. Hold a business card or other small 
piece of white paper in the beam path 
in the sample compartment to check 
for laser light.  Replace the laser if 
necessary. 

   
 The data cable between the 

spectrometer and computer is 
not properly connected. 

Turn the spectrometer power off and 
check the data cable connections.  

The Source indicator 
on the front panel is 
off. 

The source is burned out. Call Nicolet to order a replacement 
source.  Choose Replacing Parts from 
the OMNIC Help menu and the 
“Replacing a source” tutorial from the 
“Replacing parts” book to find the part 
number, ordering and installation 
instructions. 

The system does not 
scan. 

The laser is flickering. Hold a business card or other small 
piece of white paper in the beam path 
in the sample compartment to see if 
the laser light flickers.  If it does, call 
Nicolet for service. 

The signal intensity is 
low, there are frequent 
modulator scan restarts 
(verified by intermittent 
flashing of the Scan 
indicator) and the 
spectrometer alignment 
fails. 

The beamsplitter is fogged. Check the laser signals by clicking the 
laser indicator on the Diagnostic tab in 
the Experiment Setup dialog box, 
remove the beamsplitter and check the 
beamsplitter center window for 
fogging (check the clear area located 
in the center of the substrate).  Replace 
the beamsplitter if necessary. 

The signal intensity is 
low in the mid-IR 
range. 

The source is glowing 
unevenly. 

Check to see if the source element is 
glowing evenly.  Order a replacement 
if needed. 
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Problem Possible Cause Solution 

An error message 
appears when you try to 
scan. 

The light source is not 
working. 

Check the Source indicator on the front 
panel.  If the light is out, replace the 
source. 

   
 The detector is not cooled. Check and cool the detector. 
   
 The interferogram is not 

located at 1024 ±16 data points 
on the Bench tab in the 
Experiment Setup dialog box. 

Align the spectrometer.  If the 
interferogram is still not located 
correctly, call Nicolet for service. 

   
 The beam path is blocked. Hold a business card or other small 

piece of white paper in the beam path 
in the sample compartment to check for 
laser light.  If no laser light is visible 
the beam path may be blocked.  
Remove the obstruction. 

   
 The data cable between the 

spectrometer and computer is 
not properly connected. 

Turn off the spectrometer power and 
check the data cable connections. 

   
 The detector and beamsplitter 

are not compatible. 
Change the detector or beamsplitter. 

You encounter 
problems when 
selecting external 
detectors on a Nicolet 
AEM, GC interface or 
microscope. 

A custom detector is selected 
on the Bench tab of the 
Experiment Setup dialog box. 
 
A detector cable is loose at the 
accessory connector (on the 
rear of the spectrometer or on 
the back wall of the sample 
compartment). 

Change the Detector setting to None on 
the Bench tab of the Experiment Setup 
dialog box. 
 
Check and tighten the cables. 
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Problem Possible Cause Solution 

The baseline is not 
stable. 

The purge rate is too high. Lower the purge rate until the baseline 
is stable. 
 

 The center laser detector is 
misaligned. 

Use the Bench Diagnostics program to 
check the laser levels for proper 
balance.  If the levels are out of 
tolerance, align the spectrometer using 
the Align button on the Diagnostic tab 
in the Experiment Setup dialog box.  If 
the levels remain out of tolerance, call 
Nicolet for service. 

   
 The desiccant is expired. Replace the desiccant. 
   

 The spectrometer cover was 
recently opened. 

Allow the spectrometer to purge for 3 
to 5 minutes after the cover is closed.  

The Laser indicator on 
the front panel is off. 

The spectrometer cover or 
beamsplitter compartment 
hatch (760 only) is not fully 
closed. 
 
 
 
 
 
 
 
 
 
 
The laser is burned out. 
 

Turn off the spectrometer power, 
disconnect the power cord, and open 
the main cover.  Make sure the DC 
power cable connecting the power 
supply to the bottom of the electronics 
printed circuit board (located in the 
raised spectrometer cover) is not 
pinched between the spectrometer 
cover and the power supply, preventing 
the spectrometer cover from seating 
properly.  Make sure the beamsplitter 
compartment hatch (760 only) is fully 
closed. 
 
Call Nicolet to order a replacement 
laser.  Choose Replacing Parts from the 
OMNIC Help menu and the “Replacing 
the laser” tutorial to find the part 
number, ordering and installation 
instructions. 
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Problem Possible Cause Solution 

The system scans but 
gives a very low signal 
intensity. 

The spectrometer is out of 
alignment. 

Align the spectrometer.  Use the Align 
button on the Diagnostic tab in the 
Experiment Setup dialog box. 

   
 The aperture setting is wrong. Set the aperture to the proper setting. 
   
 The detector and beamsplitter 

are not compatible. 
Make sure that the selected detector 
and beamsplitter are compatible.  
Change the detector or beamsplitter if 
necessary. 

   
 There is no interferogram. If the Source indicator on the front 

panel is off, click the source indicator 
on the Diagnostic tab in the Experiment 
Setup dialog box to check the source 
current and voltage.  If the Source 
indicator is on, check the interferogram 
on the Bench tab in the Experiment 
Setup dialog box; if the interferogram 
is not present, check the beam path and 
detector. 
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Bench Diagnostics  You can use the Bench Diagnostics program to perform diagnostic 
tests on the main components of the spectrometer.  You should run 
these diagnostic tests if you have problems with your spectrometer to 
determine the source of the problem.  The diagnostics provide 
information on the status of the component as well as troubleshooting 
information, replacement procedures and information on ordering 
replacement parts. 
 
You can use the Bench Diagnostics program to: 
 
• Run the spectrometer performance test. 
• Test specific components of your spectrometer. 
• Get information about replacement parts. 
• Check the spectrometer configuration. 
• Get troubleshooting tips. 
 
Follow these steps to run the Bench Diagnostics: 
 
1. Make sure the main sample compartment is empty. 

Remove any samples and sampling accessories. 
 
 
2. Start the Bench Diagnostics software. 

Choose Advanced Diagnostics from the Collect menu, or click 
the Start button, and then choose the Bench Diagnostics icon in 
the OMNIC folder.  Some of the advanced features of the 
program, including the Performance Test, are not available if you 
run the diagnostics from OMNIC. 
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3. Follow the directions that appear on the screen to run the 
diagnostics.  

 
When you are finished viewing information in a window, you 
can use the navigation buttons to return to earlier windows.  
Click this button to return to the previous window. 
 
 

 
 
 
Click this button to return to the main Diagnostics window. 
 
 

 
 

 
Exit the program by clicking the Close button at the far right end 
of the title bar. 

 



 

Magna-IR 560 and 760 User’s Guide       147 

  Troubleshooting Applications Problems 
 
 
 

Your OMNIC software automatically checks the status of collected 
interferograms, and background and sample spectra.  When OMNIC 
performs a check and detects a problem with data collection or 
spectra, the Collect Status indicator is displayed as a yellow circle or 
a red X.  You can click the indicator (or click the View Collect 
Status button at the end of data collection) to see a summary of data 
collection problems encountered during the collection and other 
information about the collection. 
 
This chapter lists some simple troubleshooting measures you can 
take to solve data collection problems with the spectrometer.  If the 
action does not solve the problem, call your Nicolet service office.   

 
 Note For more information on troubleshooting, consult the OMNIC on-

line Help system. ▲ 
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Problem Possible Cause Solution 

There are no peaks in a 
spectrum. 

There is no sample in the path 
of the infrared beam. 

Check the sample compartment or 
accessory to make sure the sample is 
properly positioned in the beam path. 

   
 The sample and background 

spectra were collected with the 
purge shutters closed. 

Open the purge shutters and collect the 
spectra again. 

   
 The sampling cup in a diffuse 

reflection experiment is not in 
place or is tilted. 

Make sure the cup is properly 
positioned in the diffuse reflection 
accessory. 

   
 The infrared microscope is in 

its viewing mode. 
Put the microscope in infrared mode 
and collect the spectrum again. 

   
 The sample film in an 

attenuated total reflection 
(ATR) experiment is being 
held against the ATR crystal 
with uneven pressure or has 
poor contact with the crystal. 

Make sure the sample is held evenly 
and has good contact with the crystal. 

A spectrum contains 
totally absorbing peaks. 

The sample in a transmission 
experiment is too thick. 

Use a thinner sample. 

   
   
   

A spectrum contains 
fringes or channeling. 

A film sample may be too 
smooth. 

Try roughening the film surface 
slightly with silicon carbide paper or 
another suitable abrasive. 

   
 A film sample may be at the 

wrong angle with respect to the 
infrared beam. 

Try positioning the sample at a 
different angle. 
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Problem Possible Cause Solution 

A spectrum contains 
derivative-shaped 
peaks. 

A sample in a diffuse 
reflection experiment also has 
a specular reflection 
component. 

Correct the spectrum by using Other 
Corrections in the Process menu.  
(Select Kramers-Kronig.) 

   
 The infrared beam was 

reflected from (instead of 
penetrating) a flat, shiny 
sample measured using a 
specular reflection accessory. 

Try using a less reflective sample. 

The baseline of a 
spectrum is not flat. 

A KBr pellet was made with 
coarsely ground KBr powder, 
or the KBr pellet was 
improperly pressed. 

Be sure to press the pellet properly. 

   
 The background spectrum for a 

cast film was collected with an 
empty sample holder in the 
infrared beam. 

Remove the sample holder and collect 
the background again. 

   
 The spectrometer is not 

properly aligned, causing a 
sloped baseline. 

Use the Align button on the Diagnostic 
tab in the Experiment Setup dialog box 
to align the spectrometer. 

   
 The spectrometer has not been 

on long enough to reach 
thermal equilibrium. 

For best results allow the spectrometer 
at least one hour to stabilize after 
turning it on. 

   
 The spectrometer is not 

properly purged. 
Check the system to make sure that the 
correct purge gas is being used and that 
the flow rate is correct. 

A spectrum contains 
carbon dioxide peaks. 

The spectrometer is not 
adequately purged. 

Make sure you are using the correct 
purge gas and that the purge flow rate 
is adequate Allow the system three to 
five minutes to reestablish purge before 
collecting a spectrum. 
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Problem Possible Cause Solution 

A spectrum contains 
water peaks. 

The spectrometer is not 
adequately purged. 

Make sure you are using the correct 
purge gas and that the purge flow rate 
is adequate.  Allow the system three to 
five minutes to reestablish purge before 
collecting a spectrum. 

   
 The desiccant has expired. Check the desiccant and replace. 

A spectrum is too 
noisy. 

The detector is saturated. Add bandwidth-limiting filters or 
energy screens to reduce signal 
strength. 

   
 Too few scans. Increase the number of scans on the 

Collect tab in the Experiment Setup 
dialog box. 

   
 Too high resolution. Reduce the resolution on the Collect 

tab in the Experiment Setup dialog box.
 



 

Magna-IR 560 and 760 User’s Guide       151 

Index 
 

a 
A.R.K., 83 
Absorbance, 45 
absorbance units 

converting spectrum to, 44 
access doors, 61 
accessories, 81 

aligning, 134 
automated sample handling, 83 
automatic sample wheel, 83 
autosampler, 85 
available, 10 
cabling, 89 
descriptions, 82 
installing, 10, 82 
PLUS system, 85 
when to turn on, 16 

accessory 
detector, 90 
power, 90 

accessory pass-through connectors, 92 
Add Directory, 49 
Add To Library button, 55, 103 
Add To Library command, 54 
Add To Library dialog box 

adding information using, 54 
Add To Notebook, 109 
Add/Remove Programs, 20 
adding 

spectrum to user library, 54 
Advanced Diagnostics, 127, 145 
aligning 

accessories, 134 
spectrometer, 124, 132 

Analyze menu, 48, 54, 119 
annotation tool, 45, 119 

labeling peak, 46 
pointer, 46 

 
 

aperture, 72, 75 
detector affected by, 75 
effect on resolution, 75 
effect on wavenumber accuracy, 75 
for collecting data in visible spectral range, 78 
resolution affected by, 77 
size for cooled detectors, 75 
typical settings, 76 
when to use, 124 

aperture setting, 77 
applications 

troubleshooting, 147 
arithmetic operations 

performing on spectra, 117 
ATR correction, 102 
ATR needle probe and FiberLink, 82 
attenuated total reflection accessories, 82 
attenuated total reflection kit, 83 
automatically saving spectra, 106 
Autorun, 20 
autosampler, 85 
Auxiliary 1 connector, 91 
Auxiliary 1/Control Bus connector, 90 
Auxiliary 2 connector, 91 
auxiliary experiment module, 83 
 

b 
background spectrum 

collecting, 37 
defined, 28 
in Collect Sample window, 37 
when to collect, 28 

bandwidth-limiting filters, 73 
Base Name box, 106 
baseline 

correcting, 115 
not flat in spectrum, 149 
not stable, 143 

Baseline Correct, 101 
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baseplate 
removing, 82 

beam ports, 61 
beamsplitter 

aligning, 124 
changing, 8 
compatibility with detector, 69 
fogged, 141 
not compatible with detector, 142, 144 
not properly seated, 140 
spectral range, 69 
types, 68, 69 
which to use, 9 

beamsplitter compartment hatch, 61, 143 
bench cover 

when to open, 124 
Bench Diagnostics, 130 
Bench Diagnostics program, 127, 145 
Bench Diagnostics software 

and Performance test, 135 
Bench Status indicator, 27 
Blank correction, 101 
 

c 
cable 

not properly connected, 142 
cabling 

accessories, 89 
carbon dioxide peaks 

removing, 102 
changing 

beamsplitters, 8 
desiccant, 125 
detectors, 8 

channeling 
in spectrum, 148 

checking the purge, 14 
cleaning 

purge filter, 132 
Clipboard, 120 
Close button, 119 
closing 

window, 119 

Collect parameters, 34, 35 
Collect Sample, 36 
Collect Sample window, 36, 40, 97 
Collect Spectrum button, 105 
Collect Status indicator, 41 
Collect tab, 34, 35 
collecting 

background spectrum, 37 
sample spectrum, 32 
spectrum, 10, 96 

collecting spectra 
beginning to, 25 

Colors dialog box, 110 
commercial library 

finding compound in, 104 
Common Scale, 111 
components 

separating with subtraction, 117 
computer 

when to turn on, 18 
configuration 

opening, 32 
configuration file, 118 
connector 

Auxiliary 1, 91 
Auxiliary 1/Control Bus, 90 
Auxiliary 2, 91 
detector, 90 
pass-through, 89 

connectors 
for custom accessories, 92 
pinouts, 93 
rear panel, 91 
sample compartment, 89, 90 

contaminants 
identifying with subtraction, 117 

Control key 
and selecting multiple spectra, 110 

conventions 
manual, 3 

converting spectrum to absorbance units, 44 
cooled detectors 

aperture size for, 75 
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cooling 
detector, 125 
detectors, 19 

copy, 120 
spectrum, 120 

corrections 
spectrum baseline, 115 
to spectra, 101 

Create button 
for report templates, 52 

Create Library 
wizard, 5 

creating 
custom report templates, 52 
report, 51, 109 
spectral library, 103 
user library, 55 

custom accessories, 92 
 

d 
data cable, 141 
data collection 

preparing for, 6 
default.con file, 32 
Delete Files, 108 
deleting 

entire report notebook, 108 
report notebook entries, 108 
stored spectra, 108 

desiccant 
changing, 132 
expired, 143 
when to change, 125 

desiccant area, 61 
detector, 142 

accessory, 90 
affected by aperture, 75 
and energy screen, 123 
cable, 142 
compatibility with beamsplitter, 69 
linearity, 71 
not compatible with beamsplitter, 142, 144 
not cooled, 142 

optimizing performance of, 71 
photometric accuracy, 71 
saturated, 71, 74, 75 
signal intensity, 133 
silicon, 78 
spectral range, 69 
types, 68, 69 
using filter to reduce energy reaching, 71 
when to cool, 125 
which to use, 9 

detector compartment access hatch, 61 
detector connector, 90 
detector interface kit, 84 
detectors 

changing, 8 
cooling MCT or InSb, 19 

diagnostics 
Bench Diagnostics software, 130 

diffuse reflection accessories, 84 
Display Setup, 120 
Display Setup parameters 

and Window options, 111 
displaying 

library spectrum, 104 
distortion 

in spectra, 77 
dragging 

spectrum to user library, 54, 55 
dual-source option, 67 

selecting source, 67 
 

e 
Edit Menu, 118, 120 
Edit Toolbar, 118 
electronics cover, 18, 61, 66 
emission port, 61 
energy screen, 74, 77 

energy passed with, 74 
for collecting data in visible spectral range, 78 
resolution affected by, 77 
when to use, 123 

energy screens 
detectors typically used with, 74 
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entering 
Help, 5 

Expand/Contract button, 112 
experiment 

selecting, 23 
Experiment drop-down list box, 23, 33, 95 
Experiment Setup, 33, 36, 106, 134 

setting quality standards in, 98 
setting Y-axis units in, 96 

experiments 
selecting, 33 

extended search feature, 104 
extension 

.NBK (notebook), 108 

.SPA (spectral data), 108 

.SPG (spectral data group), 108 
external beam, 81 
external beam port, 61 
external source, 67, 82 
 

f 
F1 function key 

for online Help, 6, 121 
far-IR 

filters, 73 
fiber optic accessory, 84 
FiberLink, 82 
File Handling box, 34 
File Handling options, 35 
filename 

saving spectrum using current, 43 
saving spectrum using new, 43 

filter 
for collecting data in visible spectral range, 78 
installing in sample holder, 31 
reducing energy reaching detector using, 71 

filters 
bandwidth-limiting, 73 
far-IR, 73 
near-IR, 73 

Find Peaks, 119 
 
 

finding 
peak area, 114 
peak height, 114 
peaks, 119 
X and Y value, 113 

flammable gases, 15 
floppy disks 

installing OMNIC from, 20 
flowmeter, 15 
fringes 

in spectrum, 148 
front panel, 61, 66, 140, 143 
Full Scale, 111 
fuses, 140 

location, 64 
 

g 
gain, 97 

for collecting data in visible spectral range, 78 
gas cells, 84 
GC interface, 85 
Gemini, 85 
Getting Started tutorial, 2 
green check mark 

with Collect Status indicator, 41 
 

h 
hard disk 

saving spectra to, 107 
hardware 

troubleshooting, 139 
Help, 4, 121 

entering, 5 
OMNIC, 3 

 

i 
Information button, 120 
infrared source, 67 
InSb detector 

cooling, 125 
inside the spectrometer, 8 
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installing 
accessories, 10, 82 
OMNIC, 20 
sample, 9 
source, 9 

interferogram, 133, 142, 144 
interferometer 

long-stroke mode, 66, 140 
 

k 
Kramers-Kronig correction, 102 
Kubelka-Munk units, 99 
 

l 
labeling 

peaks, 119 
laser 

burned out, 143 
flickering, 141 
not working, 141 

Laser indicator, 66 
learning the software, 7 
libraries 

adding to search, 49 
library 

commercial, 104 
scrapbook, 103 

Library Creation Wizard, 55 
library groups, 49 
Library Manager, 55, 104, 105 
Library Names tab, 104, 105 
library search 

extended search feature, 104 
search expert, 105 

Library Setup, 48 
using to set up search, 48 

library spectrum 
displaying, 104 

liquid nitrogen 
cooling detectors with, 125 

live display, 133 
 

location 
fuses, 64 
power switch, 64 
purge input, 64 

log units, 99 
long-stroke mode, 66 
 

m 
maintenance, 129, 132 

spectrometer, 10 
manual conventions, 3 
Match Scale, 111 
MCT detectors 

cooling, 125 
menu bar, 26 
menu names, 26 
microscopes, 85 
mirror 

velocity, 79 
moving 

spectrum in pane, 113 
spectrum to another window, 113 
stacked spectrum, 113 

moving mirror 
velocity limitations, 79 

 

n 
near-IR 

filters, 73 
sampling accessories, 84 

noise, 76 
 

o 
Offset Scale, 111 
OMNIC 

customizing, 118 
error message, 138 
Help menu, 3 
installing in Windows 95 or Windows NT 4.0, 20 
installing in Windows V3.1 or Windows NT 3.5, 20 
online Help, 121 



156       Nicolet 

starting in Windows 95 or Windows NT 4.0, 21 
starting in Windows V3.1 or Windows NT 3.5, 22 

OMNIC icon, 22 
OMNIC window, 26 
online help 

F1 function key, 121 
how to use, 121 
symbol, 3 

online tutorials, wizards and Help, 4 
100% line, 134 
Open Configuration, 32 
opening 

bench cover, 124 
stored spectrum, 106 

optical layout, 62 
Options, 110 

in OMNIC software, 118 
Other Conversions, 96 
Other Corrections, 102 
 

p 
palette, 45 

selecting tool in, 45 
tools, 45 

parts 
replacing, 127 

pass-through connectors, 89 
paste 

spectrum, 120 
peak 

finding area, 114 
labeling with annotation tool, 46 

peak height 
finding, 114 

peaks 
carbon dioxide in spectrum, 149 
derivative-shaped in spectrum, 149 
eliminating with subtraction, 117 
finding, 119 
labeling, 119 
noise in spectrum, 150 
none in spectrum, 148 
 

totally absorbing in spectrum, 148 
water in spectrum, 150 

Percent reflectance units, 99 
percent transmittance units, 44 
performance test, 134 

not available, 145 
photoacoustic units, 99 
photometric accuracy, 71, 74 
pinouts 

connector, 93 
PLUS, 85 
power 

accessory, 90 
switch, 65 

Power indicator, 66 
power line conditioner, 88 
power switch, 17 

location, 64 
pressure regulator, 15 
previewing 

report, 52, 109 
spectra before printing, 109 

Print dialog box, 53 
printer 

specifying, 109 
Printer Setup, 109 
problems 

diagnosing, 127 
Process menu, 44, 116, 117 
ProfilIR, 85, 91 
Program Manager, 22 
pure air generator, 88 
purge, 86 

checking, 14 
flowrate, 15 
gas characteristics, 15 
how to, 8 
rate too high, 143 
when to use, 15 

purge filter 
cleaning, 132 

purge gas generator, 88 
purge input 

location, 64 
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purge shutters, 14, 61 
closing, 29 
function, 126 
opening, 32 

 

q 
quality standards, 98 

categories, 98 
Quality tab, 98 
Quantify 

command dimmed, 138 
quantitative analysis, 71, 74 
 

r 
Raman accessory, 85 
rear panel, 64 

connectors, 91 
red X 

with Collect Status indicator, 41 
Region Setup tab, 103 
remote diagnostics, 88 
removing 

baseplate, 82 
replacing parts 

in spectrometer, 127 
report 

creating, 51, 109 
previewing, 52, 109 

Report menu, 51 
report notebook 

deleting entire, 108 
deleting entries, 108 
saving spectra to, 106 

report template 
creating custom, 52 
selecting, 51, 109 

resolution 
affected by aperture, 75, 77 
affected by energy screen, 77 
and aperture, 75, 124 
effect of on signal-to-noise ratio, 76 
 

improving, 77 
incorrect setting, 138 

Results window 
viewing, 42 

Roll/Zoom window, 112, 113 
RSVP, 88 
 

s 
safety, 2 
sample 

how to install, 9 
installing in sample holder, 31 

sample compartment 
connectors, 89 
connectors in, 90 

sample compartment cover, 61 
Sample Compartment parameter, 132 
sample holder 

installing, 30 
installing sample or filter in, 31 

sample shuttle, 86, 91 
sample spectra 

adding to spectral library, 105 
sample spectrum 

collecting, 32 
entering title for, 36 
searching, 48 

sample tray, 61 
sample wheel, 83 
sampling accessories, 81, 82 
Sampling Information, 120 
saturation 

detector, 71, 74, 75 
Save, 43 
Save As, 43 
Save Automatically option, 34, 106 
Save Configuration As, 118 
Save Interferograms option, 35, 97, 106 
saving 

spectra, 106 
spectrum, 43 
spectrum using current filename, 43 
spectrum using new filename, 43 
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saving spectra 
where to save, 106 

Scale commands, 111 
Scan indicator, 66, 140, 141 
scans 

effect of number of on signal-to-noise ratio, 76 
number of, 40 

scattering, 76 
scrapbook library, 55, 103 
search expert, 49, 105 
Search Expert button, 50 
Search Results, 49 
Search window, 50 
searching 

preparing spectrum, 101 
sample spectrum, 48 
spectral library, 101 

Select Library dialog box, 54 
selecting 

an experiment, 23 
experiments, 33 
more than one spectrum, 110 
report template, 51, 109 
spectral region, 119 
tool, 45 

service, 129, 131 
setting 

aperture for a detector, 76 
software parameters, 23 

signal distortion, 74 
signal intensity, 133 

aligning, 124 
signal-to-noise ratio, 74, 76 
silicon detector, 78 
sliding door, 61 
Snap-In sample compartment baseplates, 30 
software 

learning how to use, 7 
preparing for data collection, 6, 95 
starting, 6 
troubleshooting, 137 

software parameters 
setting, 23 

 
 

source, 67 
burned out, 141 
external, 67, 82 
glowing unevenly, 141 
installing, 9 
not working, 142 
which to use, 126 

Source indicator, 66, 141 
specifying 

colors for spectra, 110 
printer, 109 
Y-axis units, 96, 99 

spectra 
automatically saving, 106 
before collecting, 13 
deleting stored, 108 
previewing before printing, 109 
specifying colors for, 110 
subtracting, 116 
where to save, 106 

spectral library 
adding spectra to, 105 
creating, 103 
searching, 101 

Spectral Math, 117 
spectral quality, 98 
spectral range 

and velocity, 79 
detector-beamsplitter, 69 
visible, 78 

spectral region 
selecting, 119 

spectral window, 26 
spectrometer, 140 

aligning, 132 
cover, 140, 143 
diagnosing problems, 127 
front panel, 66 
how it works, 8 
inside components, 8 
leaving turned on, 16 
letting stabilize, 18 
maintaining, 10 
maintenance, 129 
performance test, 134 
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replacing parts, 127 
service, 129 
turning on, 17 
when to align, 124 
when to turn off, 127 

Spectrometer Setup 
and mirror velocity, 79 

spectrum 
background, 28 
baseline not flat, 149 
converting to absorbance units, 44 
copy and paste, 120 
correcting baseline, 115 
distorted, 77 
entering title for, 36 
how to collect, 10, 96 
moving in pane, 113 
moving stacked, 113 
moving to another window, 113 
no peaks, 148 
noise in, 150 
opening stored, 106 
preparing for search, 101 
saving, 43 
saving with current filename, 43 
saving with new filename, 43 
selecting more than one, 110 
with carbon dioxide peaks, 149 
with derivative-shaped peaks, 149 
with fringes or channeling, 148 
with totally absorbing peaks, 148 
with water peaks, 150 
zooming in on an area, 112 

specular reflection accessories, 86 
Start accessory, 86 
Start button 

to open OMNIC, 135, 145 
starting OMNIC 

in Windows 95 or Windows NT 4.0, 21 
in Windows V3.1 or Windows NT 3.5, 22 

starting the software, 6 
stored spectrum 

opening, 106 
subtracting spectra, 116 
 

subtraction 
when used, 116 

symbol 
online help, 3 

system 
problem with, 11 
purging, 8 
turning on, 6 

system accessories, 88 
system components 

turning on, 16 
 

t 
task window 

closing, 119 
text 

editing in spectrum, 46 
TGA interface, 87 
title 

entering for sample spectrum, 36 
tool 

information, 46 
selecting, 45 

tools, 45 
annotation, 45 

transmission accessories, 87 
transmittance units, 44 
troubleshooting 

applications, 147 
hardware, 139 
software, 137 

turning on 
computer, 18 
spectrometer, 17 
system, 6 
system components, 16 

tutorials, 4 
Getting Started, 2 
How an FT-IR Spectrometer Works, 8 
using, 5 
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u 
uninterruptable power supply, 88 
units 

used for spectra, 44 
User Example Library, 54 
user library 

adding spectrum by dragging, 54, 55 
adding spectrum to, 54 
creating, 55 
saving spectra to, 107 

user name 
entering in OMNIC, 21, 22 

 

v 
validation wheel, 87 
velocity 

and spectral range, 79 
moving mirror, 79 

View Collect Status button, 42 
View Match List, 50 
View menu, 111, 120 
View Notebook, 109 
View tab, 110 
viewing 

Results window, 42 
visible spectral range, 78 
 
 
 
 

w 
water peaks 

removing, 102 
wavenumber accuracy, 75 
window 

closing, 119 
Window options 

and Display Setup parameters, 111 
Windows metafile, 120 
wizard 

Create Library, 5 
wizards, 4 
 

x 
X value 

finding, 113 
 

y 
Y value 

finding, 113 
Y-axis unit 

specifying, 96, 99 
yellow circle 

with Collect Status indicator, 41 
 

z 
Zoom button, 52 
zooming 

on a spectrum, 112 
 

 

 


